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Picarro Notices 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product that has been 
designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize you with the 
system and explain the numerous features that have been designed into it. Please read this 
manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions regarding 
specific applications or if you require additional information. 

DISCLAIMER AND RESERVATION OF RIGHTS 
Picarro has prepared this manual solely for the information and use by its customers as a guide for the 
selection, installation, operation, and maintenance of the products described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO PRODUCTS, 
PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS ANY EXPRESS 
OR IMPLIED WARRANTY, RELATING TO SALE OR USE OF PICARRO PRODUCTS, INCLUDING 
LIABILITY OR WARRANTIES RELATING TO MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the specifications of its 
products at any time, without notice. Picarro has endeavored to include information that is current and 
accurate as of the date of the publication or revision of this document, but Picarro does not guarantee 
that this document is error free or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual property rights 
relating to any product described in this manual. This document does not grant any license, express or 
implied, by estoppel or otherwise, to any intellectual property rights of Picarro or any third party. 

PATENTS 
The products described in this manual are subject to Picarro patents and patents pending. Information 
about Picarro patents applicable to these products is available at www.picarro.com/company/patents 

TRADEMARKS 
Linux® is a registered trademark of Linus Torvalds 
Molex® is a registered trademark of Molex LLC 
Picarro and the Picarro logo are trademarks of Picarro, Inc 
SilcoNert® is a trademark of SilcoTek® Corporation 
Snoop® is a registered trademark of Swagelok Company 
Swagelok® is the trademark of Swagelok Company 
Teflon™ is a trademark of the Chemours Company 

Copyright © 2023 Picarro™, Inc. All rights reserved.  

https://www.picarro.com/company/patents
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Contact Information 

Please contact Picarro for questions regarding specific applications and additional 
information. 

General Technical Support: 

Email: support@picarro.com 

Phone: + 1 408 962 3991

European Technical Support: 

Email: support@picarro.com 

Phone: +31 85 888 1650

Customer Service: 

Email: orders@picarro.com 

Phone: + 1 408 962 3992

mailto:support@picarro.com
mailto:support@picarro.com
mailto:orders@picarro.com
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1. Introduction
The PI2910 and PI2920 analyzers are designed to measure concentrations of ethylene 
oxide (EtO) gas. The PI2910 has been configured for measurements near the source of 
emission and can accommodate a broad measurement range of EtO in a complex air 
matrix. The PI2920 has been configured for improved sensitivity and can accommodate 
measurements of EtO further away from the source of emission (e.g., at the fenceline). A 
such, the specifications for the PI2910 and PI2920 are different. However, the setup, 
method of use, and data logging are virtually identical. 

NOTE 

Analyzer guidelines established by Picarro are provided for optimal performance 
for near source and broader range measurement. These systems can be utilized 
outside of these recommendations with the understanding of the performance 
specifications and differences. 

This manual is written for operators, service technicians and maintenance technicians 
who install, operate, and maintain the PI2910 or PI2920 analyzer. 

For calibration, repairs, or service other than user maintenance detailed in this manual, 
contact Picarro Service Engineering or your local Picarro-authorized and certified 
technicians. 

NOTE 

It is not possible to transition from a PI2910 analyzer to a PI2920, and vice 
versa. The final configuration is performed during production. 

1.1 Intended User 
The PI2910/PI2920 Ethylene Oxide Analyzer measures concentrations of 
ethylene oxide (C2H4O) gas using Picarro’s patented Cavity Ring-Down 
Spectroscopy (CRDS). Picarro’s CRDS enables state of the art lower limits of 
detection, exceptionally low drift, all in an easy to use and deploy system. It is an 
ideal tool for background, near-source, and source monitoring of EtO from a 
variety of emission sources.   

Zero drift corrections using ultra-high purity gases or cartridges are not required to 
meet instrument specifications. Additionally, carbon dioxide (CO2), methane 
(CH4), and water vapor (H2O) can be measured.  

This analyzer can be deployed in a lab or in the field, allowing in-situ analysis for 
trace EtO or ambient EtO monitoring applications. 
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1.2 System Overview 
Analyzer 
Figure 1 shows the analyzer front and back panels. More detailed information on 
panel features, functions, and connections are in section 4, Hardware Setup. 

Figure 1: PI2910/PI2920 Front/Back Panels 

A2000 Vacuum Pump 
The A2000 vacuum pump (Figure 2) is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the analyzer is in 
use. 

Figure 2: A2000 Vacuum Pump – Side Views 

Main 
Power 

Soft Power 
Button 

USB Port 

PC/ 
Communication 

Ports 

Sample Inlet and 
Vacuum Ports 

Com/Valve/ 
Optional 

Ports 



Introduction 

PI2910/PI2920 UM P/N 40-0101 Rev. B 15 

1.3 Analyzer Specifications 
Table 1: PI2910/PI2920 Specifications 

Parameter Specification 

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS) 

Weight: Analyzer 
Weight: Pump 

21.3 kg (47 lbs.) – Should be lifted by two people. 
A2000: 6.5 kg (14.4 lbs)  

Dimensions – Analyzer Depth: 59.9 cm (23.6” without handle) 
Width: 43.2 cm (17.0”) 
Height: 19.8 cm (7.8”) 
Height with Feet: 21.3 cm (8.4”) 

Dimensions – A2000 Pump Length: 27.9 cm (11”)  
Width: 10.2 cm (4”) 
Height: 19.1 cm (7.5”) 

Ambient Humidity Range < 99% RH non-condensing 

Ambient Temperature Range Operating: 0 °C to 35 °C (32 °F to 95 °F)  
Storage:    0 °C to 70 °C (32 °F to 158 °F) 

Maximum Altitude (During operation) 3,048 m (10,000 ft) 

Front/Rear Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”) 

Primary Gases Measured C2H4O Ethylene Oxide (EtO) 

Other Gases Measured CO2, CH4 and H2O 

Sample Flowrate 230 sccm at 760 torr (101 kPa) 

Required Accessories Included: Pump (external), 
Supplied by customer: keyboard, mouse, LCD 
monitor 

Operating System 
Data Outputs 

Linux Ubuntu 20  
RS–232, Ethernet, USB, Analog (optional) 0-10 V 

Installation Benchtop or 48.3 cm (19”) rack mount 

Power Requirements 
Startup Power 
Steady-state Power 

Mains Supply Voltage Fluctuation 

100 – 240 VAC; 50 – 60 Hz (auto-sensing) 
<375 W at start-up, (Analyzer and Pump) 
120 W (Analyzer) 
150 W (A2000 Pump) 
±10% of the nominal voltage 

Minimum Rated Circuit Amperage 10A @ 115 VAC 
5A @ 230 VAC 

Liquid Ingress Protection None 



Introduction 

16 P/N 40-0101 Rev. B PI2910/PI2920 UM 

1.4 Acronyms 
This manual includes various acronyms. For definitions, see below: 

Table 2: Acronyms, Formulas, Units, and Symbols 

Acronym Definition 

“ (as in 1/4”) Inches 

°C degrees Celsius 

A 
Ampere 
Accessory (internal use). Used in model names i.e. A0302 

AC Alternating Current 

AMC Airborne Molecular Contamination 

atm. Atmosphere; unit of pressure, approximately equal to atmospheric 
pressure at sea level. 1 atm. = 14.69595 psi (101.325 kPa)  

bar Metric unit of pressure. 1 bar = 100,000 pascals (Pa) 

BBCRDS Broad Band Cavity Ring-Down Spectroscopy 

cc current calibration 

CH4 Methane 

cm centimeters 

COM Communication Port 

CRDS Cavity Ring-Down Spectroscopy 

CSV Comma Separated Values 

CPU Central Processing Unit 

DC Direct Current 

DIO Digital Input/Output 

DVI Digital Visual Interface 

EMC Electromagnetic Compatibility 

ESD Electrostatic Discharge 

°F Degrees Fahrenheit 

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm) 

GUI Graphical User Interface 
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Acronym Definition 

H2CO Formaldehyde 

H2O Water, Water Vapor 

HDF Hierarchical Data Format 

Hz Hertz 

kg kilograms 

kPa kiloPascal; unit of pressure; 1 kPa = 0.145 PSI 

lbs pounds 

M meters 

max Maximum 

min Minimum 

mA milliampere 

mK millikelvin 

mm millimeter / millimetre 

nc new calibration 

NC Normally Closed 

NO Normally Open 

NTP Network Time Protocol 

OD Outside Diameter 

PAIAC Phosphoric Acid Impregnated Activated Charcoal 

PDF Portable Document Format 

PFA Perfluoroalkoxy Alkane – A chemically resistant polymer, suitable for 
use with sticky and aggressive gases 

PN Part Number 

ppb parts per billion 

ppm parts per million 

PSI (psi) Pounds per Square Inch 

PSIG Pounds per Square Gauge 

QC Quality Control 
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Acronym Definition 

RH Relative Humidity 

RJ-45 Registered Jack (physical network interface) 

RS232 Recommended Standard 232 (serial communication protocol) 

SNTP Simple Network Time Protocol 

SCCM Standard cubic centimeters per minute 

SSL Secure Sockets Layer 

SST Stainless Steel 

TCP/IP Transmission Control Protocol/Internet Protocol 

Torr Torricelli (unit of pressure equal to 1/760 atmosphere) 

UM User Manual 

USB Universal Serial Bus 

UPS Uninterruptible Power Supply 

VAC Volts Alternating Current 

VDC Volts Direct Current 

W Watts 

WLM Wavelength Monitor 

1.5 Text Conventions 
The following conventions are used in the manual. 

• Italic text identifies screen names and emphasizes important text or certain
features.

• Bold Italic text identifies section reference links.

• Bold text is for actions to take (such as clicking on a UI button), caution
and warning statements, and text you should type or select in screens.
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2. Safety

2.1 Warning Symbols 
Icon notes and warnings are used throughout this manual. The purpose of these 
icons is to provide a visual convention to alert you of important information. They 
indicate dangers to either the operator or to the analyzer, and other important 
information. 

Table 3: Warning/Information Icon Types 

Icon Description 

NOTE 

NOTE is important information that you should be aware of before 
proceeding. 

WARNING 
LASER WARNING alerts you of a laser danger. 

DANGER 

DANGER indicates an imminently hazardous situation that, if not 
avoided, will result in death or severe injury. 

WARNING 

WARNING indicates a potentially hazardous situation which, if not 
avoided, could result in death or severe injury. 

CAUTION 
CAUTION alerts user of a potential danger to equipment or to the user. 

WARNING 

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to 
electrical energy that is high enough to cause injury or death. 

CAUTION 
HOT SURFACE alerts user to potential injury from hot surfaces. 

REMINDER 

REMINDER is a helpful hint for procedures listed in the text. 
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2.2 General Safety 
CDRH Certification 
This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is 
classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 
This Picarro Analyzer complies with European safety standards and the 
instrument is affixed with a CE label. This CE label is located on the back panel of 
the instrument. 

WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

WARNING 

The analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
It is NOT protected against exposure to water including dripping, spraying, 
splashing or immersion. 

WARNING 

Do not operate in an explosive atmosphere! Do not operate in the presence of 
flammable gases or fumes.  

CAUTION 

This analyzer contains no user-serviceable components except the particulate 
filter, CPU fan, and A2000 vacuum pump diaphragms and valves. To order user-
replaceable parts and access video replacement instructions, see section 11, 
Maintenance.  

Do not attempt other repairs; instead, report all problems to Picarro Customer 
Service or your local distributor. Please contact Picarro if you have any 
questions regarding the safe operation of this equipment. 

CAUTION 

Do not replace the mains supply power cord with an inadequately rated cord. 

WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 
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CAUTION 

Equipment Damage: Exceeding gas inlet pressure or temperature specifications 
could result in damage to the instrument. In the case of higher input pressure or 
flow, configuring a sampling bypass manifold system is recommended. 

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream 
appropriately. 

WARNING 

The inlet and outlet gas connectors on the back panel of the analyzer, and its 
immediate vicinity, runs hot during operation of the analyzer. Take care when 
connecting gas lines or working at the rear of the instrument to wear protective 
gloves or avoid contact with these surfaces. 

CAUTION 

Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum 
line, or the AC power to the External Vacuum Pump while analyzer is operating. 
Damage may be caused by current surges if power is applied while attaching or 
removing cables. 

WARNING 

This analyzer weighs 21.3 kg (47 lbs). Use the technique described below (or 
follow your local regulations) when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp edges.
b. Lift with two people, one on each side of the analyzer.
c. Crouch down and stay close to the unit. Always keep your back as

straight as possible.
d. Position your feet for sturdy balance. Lift with your legs, not your back.
e. Do not twist the back while carrying the unit. Rotate direction with hip

joints.
f. Lower the unit by bending at the knees.

2.3 Laser Safety 

WARNING 

This equipment is classified as a Class 1 laser product with an embedded 3B 
laser in accordance with EN 60825-1:2014. Do not to open the enclosure where 
this label is placed; there are no user serviceable parts inside. 

The following Laser Safety Label is affixed to the outer cover of the analyzer. 

Figure 3: Laser Safety Label – Affixed to Outside Cover of Analyzer 
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WARNING 

The laser is a Class 3B when exposed. 
Only operate or service this device in accordance with the instructions in this 
guide, and only open the device in an approved laser safe service area using 
appropriate laser-safety glasses. 

The following Laser Safety Label (Figure 4) is affixed to the inside of the 
analyzer: 

Figure 4: Laser Safety Label – Affixed to Inside of Analyzer 

CAUTION 

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 
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3. Unpacking

3.1 Inspect the Shipping Boxes 
Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from damage 
during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 
analyzer and most of the accessories. Even if the outer box shows damage, the 
inner box holding the analyzer will protect the instrument under most 
circumstances. 

If the equipment does appear to be damaged, photograph the damage and 
contact Picarro (email pictures if possible) as soon as possible. 

NOTE 

Keep all packing materials so the instrument can easily be returned Picarro if 
necessary or transported to another location. 

3.2 Unpack Components 
While unpacking each shipping box: 

• Inspect each item to ensure it is not damaged.

• If items are missing, contact Picarro.

• Keep the shipping materials to reuse when transporting the analyzer.

• Contact Picarro for options on transporting systems to remote labs.

WARNING 

The analyzer weighs 21.3 kg (47 lbs). Use the technique outlined on Page 21 
when lifting or moving the analyzer.  
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Figure 5: PI2910/PI2920 Shipping Box Contents 

Table 4: Box One: Analyzer and Accessories 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to perform 
all gas handling, spectral collection, and analysis. 

AC Power Cables (1) A power cable with connectors appropriate to your 
country is provided. Note: The analyzer 
automatically adjusts to local voltage.  

Control Cable Kit (1) For External Solenoid Valves. 

Nut (1) and Ferrules (2) For connecting input line to analyzer gas INPUT. 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Keyboard and Mouse (1) Monitor is not included. 

USB Flash Drive Contains backup software. 

Document Packet (1) Includes this user manual and certificate of 
compliance (not shown). 

USB 
Backup 
Software 

A2000 Pump to 
Analyzer 
Vacuum Hose 

A2000 Vacuum 
Pump 

Control Cable 
for External 
Solenoid 
Valves 

Connectors for 
Control Cable 

Analyzer User Manual 

Analyzer 

Mouse Pad 
Keyboard and Mouse 

Power Cables 

A2000 Pump 
Manual 
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Table 5: Box Two: A2000 Vacuum Pump and Accessories 

Item (qty) Description 

A2000 Vacuum Pump (1) Provides vacuum required for sample gas 
sequencing into and out of the analyzer. 

AC Power Cable (1) A power cable with connectors appropriate to your 
country is provided. 
Note: The vacuum pump voltage must be selected. 
See Set A2000 Pump Input Voltage in section 4.3. 

Pump Manual (1) Detailed instructions for pump. 
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4. Hardware Setup
Read this entire section before proceeding. Some of the setup instructions in this 
section are model-dependent. 

4.1 Items/Tools Required 
• Analyzer and accessories included in shipment

• Pump (Model dependent; see specifications in Table 1) and accessories
included in shipment

• 5/8” open end wrench

• 11/16’’ open end wrench

• Power Cords for analyzer and pump

4.2 Installation Safety 

WARNING 

Two-person lift required: The analyzer weighs 21.3 kg (47 lbs). When lifting the 
analyzer, use the technique described on page 21 (or follow your local 
regulations).  

CAUTION 

When the analyzer is being integrated to an external system, the safety of that 
system is the responsibility of the assembler of that system.  

WARNING 

Equipment Damage: Do not attach electrical power to or start the analyzer until 
after attaching and turning on the External Vacuum Pump. Do not disconnect the 
vacuum line while the analyzer is running. Failure to do so could result in 
damage to the optics. 

WARNING 

Picarro sells certain USB enabled devices, such as GPS, which are approved for 
use. Do not connect USB hubs or unauthorized USB devices (except flash 
drives, mice, and keyboards) to the USB ports. Unauthorized USB devices may 
interfere with the normal functioning of the analyzer. 

Warning 

When using compressed gases, follow all appropriate safety conventions, 
including use of eye protection, physical restraint of cylinders, etc. 
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CAUTION 

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 
15 PSIG of pressure. 

CAUTION 

During installation, do not position the analyzer so that it is difficult to operate 
the electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 

CAUTION 

Use the AC power cables supplied with the analyzer or a similarly rated cable. 
Check with Picarro technical support if you have questions about power cable 
replacement. An inadequately rated power cable can result in equipment 
damage. 

CAUTION 

Cords shall be RATED for the maximum current for the equipment and the cable 
used shall meet the requirements of IEC 60227 or IEC 60245. Cords certified or 
approved by a recognized testing authority are regarded as meeting this 
requirement. The connector type used should be: IEC320 C13. 

CAUTION 

Equipment Damage: It is imperative that the analyzer have adequate ventilation 
and/or cooling to maintain the ambient temperature below 35 °C when operating. 
Do not place the pump or the instrument in any enclosure without providing 
adequate forced air flow. 
Do not plug or block any perforations in the chassis of the instrument. Do not 
put anything near the instrument that will impede the air flow. Failure to provide 
adequate airflow, especially clearance at the front and rear panels, to ensure 
proper airflow and/or cooling to the analyzer will result in overheating of the 
analyzer causing a shutdown and potential damage. There should be 6” (15 cm) 
of clearance in the front and back of the analyzer. 

To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperatur3e is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below. 

Thermal Specifications Min Max Description 

Ambient Operating 
Temperature 

0 °C 35 °C Worst-case environmental limits 
(unless otherwise specified) 
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CAUTION 

If the analyzer has been stored at less than 10 °C, allow the components to 
equalize to room temperature before starting the installation process. 

4.3 Analyzer Preparation 
Ventilation Considerations 
The instrument and pump require adequate ventilation in order to function 
properly. Do not plug or block any perforations in the chassis of the instrument. 
Don’t place anything near the instrument that will impede the air flow.  

Positioning 
1. Remove the analyzer and the external vacuum pump from the shipping

container.

2. Install the analyzer in a rack or place it on a cart or table.

3. Place the external vacuum pump near the analyzer in a rack, or on a
cart or table.

4. Unpack the analyzer accessories (vacuum line, cable kit, manual, and
certificate of compliance).

NOTE 

Store the certificate of compliance in a safe place. It may be required if you 
contact Picarro for service or questions. 

5. Remove the caps from the analyzer SAMPLE inlet and VACUUM
connection ports.

6. Remove the caps from the pump vacuum inlet (and exhaust port if using
an A0702 or S2000 pump). Save the caps for reuse in case the analyzer
and pump is stored, moved, or shipped.

Set A2000 Pump Input Voltage 
7. If using an A2000 vacuum pump, set its input voltage to the correct level

for your area by rotating the voltage selector switch located on the side
of the pump next to the fuse holder (Figure 6).

Figure 6: Vacuum Pump Voltage Selection 

Input Voltage Selector 
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4.4 Connections – A2000 Pump and Gas Inlet 
Follow instructions in this sect ion when using an A2000 pump with your analyzer. 

Pump Connections 
Refer to Figure 7 when using an A2000 pump with your analyzer. 

Figure 7: Analyzer Setup with A2000 Pump 

CAUTION 

When working with hazardous gases, remove the pump exhaust muffler and 
adapt a tube to the vacuum pump exhaust port (shown in Figure 6) and direct the 
exhaust to a safe place for venting the mixture of sample gases. For 
instructions, see APPENDIX D – Setting up Contained Exhaust Flow. 
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1. Connect the provided vacuum line between the analyzer port labeled
VACUUM and the pump vacuum inlet.

2. If working with hazardous gases, see APPENDIX D – for instructions on
directing the pump exhaust to a safe venting environment.

Sample Gas Inlet Connections 
There are two types of sample Inlet connections which are model-dependent. 

• Analyzers that have stainless steel (SST) sample inlet connectors.

• Analyzers that have PFA sample inlet connectors.

Sample Gas Inlet Connection (SST Tubing 
3. Use 1/4” OD SST tubing and connector sets to connect from sample

source to the sample inlet.

4. Place the two ferrules inside the nut as shown below.

Figure 8: Orientation of Inlet Nut and Ferrules 

5. Loosely connect the nut to the INLET on the back panel of the analyzer,
being careful not to let the ferrules fall out.

6. Insert the tubing into the back of the nut and through the ferrules,
feeding it in as far as possible without deforming the tubing.

7. Hand tighten the nut.

8. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns.

When reconnecting SST tubing: 

9. Inspect the ferrules. If you see any damage, replace the ferrules and
follow the directions above for making a new connection.

10. If there is no damage, hand tighten the connector to the analyzer
sample inlet.

11. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°).
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Sample Gas Inlet Connection (PFA Tubing) 
When making a new PFA gas inlet connection: 

1. Use 1/4” OD PFA tubing and connector sets to connect from sample
source to the sample inlet.

2. Place the two PFA ferrules inside the PFA nut as shown in Figure 9.

Figure 9: Orientation of Inlet Nut and Ferrules 

3. Loosely connect the nut to the INLET on the back panel of the analyzer,
being careful not to let the ferrules fall out.

4. Insert the tubing into the back of the nut and through the ferrules,
feeding it in as far as possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another
60°).

When reconnecting PFA tubing 

1. Inspect the ferrules. If you see any damage, replace the ferrules and
follow the directions above for making a new connection.

2. If there is no damage, hand tighten the connector to the analyzer
sample inlet.

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°).
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4.5 Electrical Connections 
Refer to Figure 10 for connection points. 

1. External Vacuum Port to Vacuum Pump
2. Gas Sample Inlet
3. USB Ports (4 ea)
4. Display Port
5. COM 2 Port (Rotary valve –  A0311, A0311-S)
6. COM 1 Port
7. HDMI Video Monitor Port (typical)
8. DVI-I Video Monitor Port
9. USB Ports (2 ea)

10. Ethernet Ports – RJ-45 (2 ea)
11. Audio In/Out Ports
12. AC Power Input and Power ON Switch
13. Valve Control Port (Solenoid valves)
14. DIO (Not connected)
15. COM 3 Port (Connected but typically not used.)
16. Analog EIC Output (Optional upgrade)
17. USB for Logic Board (Not connected)

Figure 10: Annotated Back Panel Diagram 

1. Connect a monitor to one of the DVI monitor ports at the back panel.
The analyzer will detect the connection and adjust the resolution to
match the monitor.

2. Connect a mouse and keyboard to a pair of USB ports.

3. Connect the provided AC power cable from the analyzer to the power
source.

NOTE 

The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max. 

1 
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NOTE 

The A2000 pump does not automatically adjust to power sources. If using the 
A2000 vacuum pump, ensure its input voltage is set to the correct level for your 
area by rotating the voltage selector switch located on the side of the pump next 
to the fuse holder (see Figure 6). 

4. Check that the A2000 pump voltage input switch is set correctly.

5. Connect the provided AC power cable from the vacuum pump to the
power source.

6. If used, connect the valve cable from the analyzer back panel to any
solenoid valves.

7. If used, connect rotary valve (A0311, A0311-S) to COM2 with its
provided serial cable.

4.6 Manifold Compatibility 
The selection of an A0311 or A0311-S manifold depends upon the user's needs. 
The A0311-S manifold flushes all inactive lines providing the most instantaneous 
measurements when switching to the next pre-purged position. However, it also 
pulls more total flow from all positions, which all users may not require or desire. 
The A0311-S has short portions of PFA Teflon, which can have memory effects if 
a user sees very high and low concentrations in the same position. 

The A0311-S is the more responsive choice for EtO applications, but some users 
may prefer the A0311. For more information, see Appendix D - External Valve 
Sequencer. If additional help is required, contact mailto:support@picarro.com to 
discuss with a technical representative. 

mailto:support@picarro.com
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5. Analyzer Basic Operation
This section explains how to operate the analyzer using the GUI. It describes system 
startup, shutdown, and recovery procedures, desktop features. GUI Functions are 
detailed in section 6, List of GUI Functions. 

WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

CAUTION 

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

5.1 Startup 
1. Make sure the pump vacuum hose is connected between the analyzer

and pump.

CAUTION 

Always turn on the external pump before powering up the analyzer. This ensures 
a safe start-up sequence. 

2. Verify the power cable to vacuum pump is plugged in.

3. Switch power on at the pump.

4. Verify the power cable to the analyzer is plugged in.

5. At the analyzer back panel, press the main power switch to the ON (“I”)
position.

6. If needed, press the round Soft Power button on the front panel. The
indicator LED will illuminate green.

The Picarro Launch Pad user interface displays and the CRDS Data
Viewer (Figure 11) automatically starts within 30 seconds. For more
information about the CRDS Data Viewer features, see section 6.1, GUI
Overview.
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The analyzer will not begin producing data until the cavity temperature 
and pressure have reached their operational set points. A message will 
display in the Status Log window (see Figure 11, bottom panel) when 
each set point is reached. An explanation of the most common status log 
messages can be found in section 6.10, Measurement Status Log. 

Data will be saved automatically once the analyzer starts to produce data. The 
data in the GUI is the continuous real time read out from the analyzer. User data 
is stored in: 

/Home/Picarro/I2000/Log/DataLogger/DataLog_User/YYYY/MM/DD, where 
Y=year, M=month, D=day. Further details can be found section 8, File 
Management. 

In order to measure discrete samples (such as individual gas bags) or from 
multiple locations (when switching valves draw in ambient air from different 
heights) a separate software window (coordinator) is used to control the sample 
source and match the corresponding real time read out with the sample source. 
Depending on system configuration, coordinator programs may not be included. 

Figure 11: Picarro Analyzer GUI 
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5.2 Shutdown 

CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. 

CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating. 

1. With the pump still running, switch to a source of clean, dry gas at the
sample inlet and allow it to run until the water channel reading on the
GUI falls below 0.2% (2000 ppm). This will prevent any damage from
condensation to the cavity surfaces. This dry gas may be from a tank
(target 2-3 PSIG pressure) or from a desiccant column like the DrieRite
column, C0360, sold on store.picarro.com).

2. From the CRDS Data Viewer select the Quit button located in the lower
left corner of the window.

3. A message displays () prompting the user to confirm the shutdown.
Once confirmed, the CRDS Data Viewer turns off.

Figure 12: Stop Data Acquisition/Shutdown Confirmation Dialog 

4. From the Picarro Launch Pad select Power Off to tun off the
hardware.

5. Manually turn off the pumps and dry gas (only if system requires it).

NOTE 

Leave any dry gas or desiccant attached to the inlet during this process. 
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6. When the instrument fans audibly turn off, and when the green power
button light on the front of the instrument turns off, shut off the pump
manually from the rocker switch located on the pump.

5.3 Analyzer Restart after Electrical Power Outage 
If power to the analyzer is cut-off for any reason the analyzer will cease operation. 
However, when the power is reapplied, the analyzer will restart automatically, the 
Picarro software tools will properly close out previous files and open new files for 
data collection so that previously collected data, instrument diagnostics and other 
parameters recorded up to the time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends 
using an uninterrupted power supply (UPS) to protect the data stream and the 
health of the cavity. 

5.4 Picarro Launch Pad 
The Picarro Launch Pad is the entry point for starting and using the analyzer. It 
provides access to the CRDS Data Viewer, tools, settings, and administrative 
controls for the instrument such as managing user accounts. This section 
provides an overview of the Picarro Launch Pad’s key features with additional 
information throughout this manual.  

NOTE 

Note Picarro Launch Pad features vary depending on user account types. Each 
section describes the account type that is required for each of the main menu 
options. 

Home Menu 
Account Type: All Users 

The Picarro Launch Pad automatically starts in Guest account mode and displays 
the home menu upon startup of the analyzer. Note several options are not 
accessible until you login with a user account. The Home menu options are 
provided, as shown in Figure 13. 
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Figure 13: Picarro Launch Pad/Home Menu 

• Start Analyzer – Starts the ethylene oxide analyzer and launches the
CRDS Data Viewer.

• Data Viewer – When clicked, a window opens that allows you to convert
between *.dat and H5 data files and to make various graphical
representations of your data over time periods longer than what is
available in the software buffer. The instructions on using the Data File
Viewer software are described in APPENDIX A – Setup Tools and
Communication.

Note requires login to the Picarro Launch Pad.

ZRM – Launches the Zero Reference Module (optional peripheral). Note
requires login to the Picarro Launch Pad. For more information, see the
A0601 Zero Reference Module User Manual.

Log In – Provides access to the Picarro Launch pad and tools associated
with a specified user account. Note options vary with different types of
user accounts.

• Profile – Provides access to the User Management Tool to allow regular
users to change their own password and administrators to manage user
accounts. Note requires a password to obtain entry. For more information,
see View My Profile and User Management.

• Log Out – Concludes the user account session.
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Tools Menu 
Account Type: Operators, Technicians, and Administrators 

The Tools menu provides additional utilities for the instrument and include the 
following options as shown in Figure 14. 

Figure 14: Picarro Launch Pad/Tools Menu 

• Copy Files – Allows data to be copied to an external device. Requires
technician or administrator permissions.

• User Calibration – Allows adjustment of slope and intercept for
concentration calibration to maintain accuracy. For more information, see
Chapter 9 Calibration.

• Field Laser Cal – Launches the SGDBR calibration utility to update the
laser calibration.

• Ringdown Viewer – Provides visual ring-downs for evaluation of CRDS
operations.

• Flow Controller – Safely starts pressure control to bring the cavity to the
setpoint pressure.

• Controller – Displays the Cavity Ring-Down Spectrometer Controller to
view technical information about the analyzer operation.

• TeamViewer – Starts TeamViewer for remote access and remote control
of the analyzer. Can also aid in file transferring and customer support.

• Support Export – Opens the CRDS Diagnostic Data Collector tool to
curate support data for troubleshooting.
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Settings Menu (Setup Tools) 
Account Type: Technicians and Administrators 

The Settings menu provides various configuration options for the analyzer and is 
described in detail in APPENDIX A – Setup Tools and Communication. 

Administration Menu 
Account Type: Administrators 

The Administration menu provides the following options as shown in Figure 15. 

Figure 15: Picarro Launch Pad/Administration Menu 

• Windowed Mode – Displays the Picarro Launch Pad and utilities as
windows within the user interface.

• Network – Provides configuration of network settings.
• Clock – Sets the time of the hardware clock.
• User Accounts – Provides access to the User Management Tool for

managing user accounts, security settings and user history. Requires a
password to obtain entry. For more information, Chapter 7 User
Management.

• System Backup – A mechanism for backing up or restoring system
settings.

• Toggle Modbus – Allows enabling and disabling of the Modbus interface
for configuration of the communication protocol.

• Launch Shell – Opens a command line interface.
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6. List of GUI Functions

NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

6.1 GUI Overview 
The features of the GUI in Figure 16 are described in the following sections. 

1. Users, View, Tools, Settings, and Help menus
2. Digital Readouts and Statistics
3. Instrument Status
4. Alarms Panel
5. Quit Button
6. Restart User Logs and Data Log (filename, path)

7. Status Log Window
8. Data Source, Data Key, and Precision pull-

down menus for data window content
9. Axis Auto Scaling
10. Reset Data Buffer
11. Data Windows

Figure 16: Layout of PI2910/PI2920 Analyzer GUI 
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6.2 Users, View, Tools, Settings, and Help Menus 

Figure 17: Menu Toolbar Options 

Users Menu 
• User Login – Provides access to the CRDS Data Viewer. If you do not

have an account one can be created by an administrator.

View Menu 
This menu item has three entries: 

• Lock time axis when zoomed/Unlock time axis – When locked,
forces the two graphs to display the same time scale during zoom.

• Statistics – Toggles the measurement statistics display, see the section
Digital Readouts.

• Instrument Status – Toggles the instruments status display. See the
section Instrument Status.

• Graph – Number of Graphs: Set the desired number of line graphs to
be visible on the CRDS Data Viewer. Note the data buffer resets when
the number of graphs are changed.
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Figure 18: Configure Graph Window 

Tools Menu 
This menu item has three entries: 

• User Calibration – Opens the password protected user calibration
window (default password is picarro).

Calibration slope and intercept can be entered, and their effects
immediately seen in the data. See section 9, Calibration for more
information.

• User Administration – Provides access to User Management options
for managing user accounts, policies, viewing histories and profliles.

• Show Valve Sequencer GUI – Toggles the display of the external valve
sequencer window (user may need to hit alt-tab to bring it to the front).

Settings Menu 
This menu item has a single entry called GUI. When selected it provides the GUI 
Properties window (18) which allows you to set the number of graphs displayed 
and to enable the control of Valve Sequencer from the main GUI.  

Help Menu 
• About – Displays the software release version of the instrument.

6.3 Alarms Panel 
This panel is used to monitor the status of the internal instrument alarms. These 
indicators are gas concentration alarms, such as “H2CO Too High/Low” 
depending on instrument configuration. The gas concentration alarm icons are off 
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(grayed) when the respective concentrations are below a certain value, and they 
are illuminated red when the respective concentrations are above/below a certain 
value.  

CAUTION 

High/low alarm settings are not intended as a safety measure as configured at 
the factory, either with respect to human health or the health of the analyzer. It is 
up to the customer to determine the meaning and level of a “high” or “low” value 
based on their application. 

Figure 19: Alarm Panel 

To view the alarm set point, click on the Alarm Icon and a dialog box will appear 
indicating the alarm setting and allow the user to enable it or change the setpoint. 

Figure 19: Alarm Settings Dialog 

Type the value you wish to set the alarm to and click the OK button or Cancel if 
you do not wish to change the alarm value. If you do nothing, the dialog box will 
disappear, and the alarm value will remain unchanged. The units are those that 
appear in the GUI graph.  
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6.4 Digital Readouts 
Displays the latest value recorded for the selected Data Key for each Data 
Window. Changing the Data Key changes the Digital Readout as well as the Data 
Window view. If the Statistics entry is enabled in the View menu, the mean, 
standard deviation and slope of the data in the graph is dynamically calculated 
and indicated below the digital concentration readout. These numbers change to 
reflect statistics of whatever data is in the data window. Zooming into a section of 
existing data will show the statistics statically for that time period, while the digital 
readout above the statistics continues to update with the latest value. See 6.12, 
Graph Zooming for more information. 

Figure 20: Digital Readouts Panel 

6.5 Instrument Status 
If the parameters are enabled through the Instrument Status entry in the View 
menu on the main toolbar, digital readouts for Warm Box temperature, Cavity 
Temperature and Cavity Pressure are displayed below the digital readouts panel. 

Figure 21: Instrument Status Panel 

With Show Statistics 
Enabled 

With Show Statistics 
Disabled 
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6.6 Quit and Restart User Log(s) Button 

Figure 22: Quit/Restart User Log(s) 

Restart User Log(s) Button 
The Analyzer automatically records all data collected on the instrument as .dat 
files. These are described further in section 8, File Management. 

To start a new data file (time-coded to the current second), click the Restart User 
Log(s) button. The new file name should be visible beneath the button in a few 
seconds. 

Data Log Filename and Path 
The filename and path of the active data log is displayed in this pane. The 
indicator is grayed-out when there is no active data log before gas measurement 
reporting begins. A new file is generated when the instrument starts reading gas 
concentrations, (e.g., “153719”) and subsequently at 1-hour increments (e.g., 
“163719”, “173719”). A new day folder (e.g., “2021\07\16”) will be generated at 
midnight, as will month and year folders at the appropriate times.  

Figure 23: Data Log Filename and Path Panel 

6.7 Data Window 
The data window displays a graph of any stream of data vs. system time, with a 
format of hh:mm:ss. The user can select which data streams are displayed using 
combinations from the Data Source and Data Key pull down menus. The 
precision displayed can be adjusted using the Precision menu. Auto-Scaling of 
the Y-axis is also available. Clicking any Autoscale button autoscales its Y-axis if 
the plot hasn’t done this automatically. 
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Figure 24: Data Window Panel 

6.8 Data Source and Data Key Pull Down Menus 
Data Source and Data Key menus (Figure 25) enable selection of the data stream 
that is viewed in the data window.  

• Gas concentrations: If ‘EtO Analysis’ (where EtO) represents the system
installed) is selected.

• Sensor Readings: If “Sensors” is selected, the analyzer’s optical cavity
pressure or temperature can be viewed, as well as the temperature of the
electronics of the analyzer (“DASTemp”, not directly controlled), and the
temperature of the analyzer’s wavelength monitor, indicated as
“WarmBoxTemp.”

Data Source, Data Key, Precision and Y-Axis Auto-Scale Controls 
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Gas Concentrations 

Sensor Readings 

Figure 25: Data Source and Data Key Pull Down Menus 

6.9 Precision Pulldown Menu 
Click on the pull-down to select the precision displayed on the y-axis; between 0 
and 4 digits of precision or auto. The currently selected precision is displayed 
during operation. This does not affect the precision of the saved data in the data 
log files or results files. Auto precision is sufficient for nearly all applications. 

Figure 26: Precision Pull-down Pane 

6.10 Measurement Status Log 
This window displays instrument status messages, in the following form: 
YYYY,MM,DD hh:mm:ss, then ‘Generic message text’. 
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Common Status Log Messages 
Following are the most common messages that appear: 

• Pressure Stabilizing/Locked: Displayed when the valve control system
begins to allow flow through the analyzer and stabilizes the pressure
inside the cavity.

• Temperature Locked: WB (HB): When the temperatures of the
warmbox (wavelength monitor) and hotbox (cavity) have stabilized.

This is typically the longest step in the startup sequence. Startup:
Depending on ambient temperature, the analyzer and its hotbox
temperature set point, this step may take as little as 20, or as much as 60
minutes. Restart: If the instrument is only stopped briefly, this may take a
few seconds to a few minutes.

• Preparing to Measure: Spectral scanning has started. Concentration
measurements will be available in approximately 30 seconds. The
instrument will continue to scan and report concentration measurements
until the instrument is shut down.

• Measuring: This is the normal mode of operation after startup has
completed.

Figure 27: Analyzer Status Log 

6.11 Reset Buffer Button 
Click this button to clear the internal data buffer of the GUI (this clears the current 
data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by 
the instrument. 

6.12 Graph Zooming and Panning 
Zooming In/Out 
To zoom in on a specific region of the graph, move the cursor to the area of 
interest, click/hold the left mouse button, then drag as desired to create a box 
that covers the region of interest (see Figure 28). When the box is drawn, release 
the left button and the boxed area will automatically scale to fill the data window.  
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Figure 28: Data Graph Zoom Function 

To zoom back out to see all data in the buffer, double-click left button within 
the graph display. To zoom out indefinitely, right click. Right clicking multiple 
times zooms out further. To auto scale the y-axis of either graph, use the auto-
scale buttons below the graph.  

To Zoom the X and Y axes: hold down the control button and move the cursor 
up/down or left/right using the right mouse button.  

Lock/Unlock Time Axis 
Zoom and pan features are often useful when time axes are locked, and the user 
wishes to align the Y axis in multiple plots. To lock or unlock the time axis of each 
graph during zooming, from the View menu, select Lock time axis when 
zoomed or Unlock time axis. 

Planning 
To pan the data in the X or Y axis: hold down the control button and drag the 
cursor using the left mouse button.  

Example only. The 
gas species on your 
analyzer may differ. 
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7. User Management

7.1 Overview 
User management includes: 

• Managing user accounts, such as adding users and changing passwords.

• Setting user policies, such as password requirements and session
duration.

• Viewing and saving user histories.

There are three user roles defined in the system: operator, technician, and 
administrator. The permissions are as follows: 

Table 6: User Accounts/Functions 

Function 
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View Data Viewer • • • • 

Set Alarms • • • 

Configure Data Viewer (partial) • • • 

Quit Measuring • • • 

Quit (software shutdown) • • • 

Configure Data Viewer (full access) • 

User Management • 

User management settings are available from the Tools menu in the Data Viewer 
or by using the Picarro Launch Pad. Use one of the following procedures. 

From the Data Viewer: 

1. From the Users menu, select User Login.
2. Login as an administrator (default user name is admin; default password

is admin).

3. From the Tools menu, select User Administration to view the User
Management window as shown below.
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From Picarro Launch Pad: 
1. Login to the Picarro Launch Pad as an administrator (default user

name is admin; default password is admin).

2. Select Administration and User Accounts.

3. From the User Management Tool login as an administrator (default
user name is admin; default password is admin).

4. The User Management window displays.

The User Management window has four tabbed states: User Accounts, User Policies, User 
History and My Profile. 

Figure 29: User Management Window 

7.2 Manage User Accounts 
From the User Accounts tab, perform any of the following tasks: 

• Add new users

• Disable users

• Change user passwords

• Change user roles
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NOTE 

The default user names that are shipped with the analyzer are tech, operator, 
and admin. The default passwords are tech, operator, and admin, respectively. 
User names and passwords are both case sensitive. 

Figure 30: User Accounts Tab 
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To change a Password 
1. In the User Management window, click the User Accounts tab.

From the list of users, click the user you want to change from the Edit
User dialog.

Figure 31: Change Password 

3. In the Password field, enter the new password.

Passwords are case sensitive. Additional rules for passwords can be set
in the User Policies tab (see page 57).

4. In the Password Confirmation field, re-enter the password.

5. Click Next to save the password

NOTE 

To change your own password for your account, see View My Profile. 



User Management 

PI2910/PI2920 UM P/N 40-0101 Rev. B 55 

To Change a User’s Role 
1. In the User Management window, click the User Accounts tab.

2. From the list of users, click the user you want to change from the Edit
User dialog.

3. From the Role field, select the new role and click Save.

Figure 32: Change Roles 

To Disable a User Account 
Users cannot be deleted from the system, but they can be disabled so they will 
not have access to the software. 

1. In the User Management window, click the User Accounts tab.

2. From the list of users, click a user name.

3. Click Disable User; this will prompt you to confirm your choice.

4. Click OK to confirm the action.
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To Add a User 
1. In the User Management window, click the User Accounts tab.

2. Click Add User; this will display the Add User screen.

Figure 33: Add User 

3. Fill in the fields in the Add User window.

4. Click Save to open the New User Account dialog.

5. Review the user information and click OK to accept or Cancel to go
back and edit the information.
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Set User Policies 
1. In the User Management window, click the User Policies tab.

Figure 34: User Policies Tab 

2. Make the changes you want. The following table provides descriptions
for the various user policies.

Table 7: User Policies 

Policy Description 

Password length Specify that the length of passwords (6–15 characters) or 
turn off the length requirement. 

Password complexity When selected, all new passwords must have at least one 
number, one letter, and one special character. This will not 
impact existing passwords. 

Password expiration When selected, any passwords that reach the selected 
maturity will expire. Any user signing in with an expired 
password will be required to create a new password. 

Previous passwords When set, prevents a user from reusing a recent password. 
The system can remember up to 10 old passwords. 



User Management 

58 P/N 40-0101 Rev. B PI2910/PI2920 UM 

Policy Description 

Limit login attempts Tell the system to disable a user account after a set 
number of failed password attempts. The failed attempts 
are counted until the user successfully logs in. Once 
disabled, an admin will have to enable the account. 

Lock session When set, the system will automatically logoff any user 
after a set period of inactivity, requiring the user to sign in 
again. 

Change password Allows the user to change their own password. 

Change phone number Allows the user to change phone number and restrictions. 

Change email Allows user to change their email address. 

Change name Allows the user to change first and last name. 

Save user actions When enabled, user actions (such as logging in) will be 
saved in the User History. 

3. Click Save. If you typed an incorrect value and want to undo any
changes and revert back to the last saved configuration, click Revert.
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View User History 
1. In the User Management window, click the User History tab to see a list

of all the logged events.

Figure 35: User History Tab 

2. Click the < and > buttons to navigate through the history (if the button is
grayed out, then there are no additional pages).

3. To make sure the content is up to date, click Refresh.

4. To copy the user history onto a USB drive, click Download. This will
direct you to the File Manager, which will prompt you to login again. See
page 48 for details on copying files from the analyzer
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View My Profile 
The My Profile tab provides information about the user that is currently logged into 
the system. The change password, phone number, email and name options are 
available to the user if these settings were enabled in the User Policies tab by an 
administrator. The user can use these options to edit their own profile information. 

Figure 38: My Profile Tab 
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8. File Management
The Picarro Analyzer generates ASCII-format text output files that are updated after 
each batch of concentration measurements is complete. The data files are stored 
primarily in DataLogger folders and are also mirrored in folders which retain more 
situational data. Some analyzers also produce discrete measurements stored in 
separate isotope data folders. All user data is ultimately archived, compressed, and 
retained, either shortly after the measurements or at a later point, to optimize space on 
the hard drive. 

8.1 Data Archive 
The archive directory is: 

/Home/Picarro/I2000/Log/Archive 

and has subdirectories: 

DataLog_Private, DataLog_User, EventLogs, and WBCAL with files arranged 
by year\month\day\hour. 

The Data Logger files are in a simple text format (white-space delimited) with a 
DAT file extension. By default, each file stores one hour of data. 

Using the Data Logger Setup Tool, the user can select and customize the data 
columns, file length, total storage size and folder structure for the user data logs. 
For more information, see Data Logger. 

Certain instruments may contain additional sub-folders under: /Home/UserData 
relating to time synced file formats, soil flux, or GPS data, among others. If the 
user has any questions about this file structure, they can contact Picarro Support. 

There are complete data files which include additional information beyond the 
concentration data including parameters such as instrument temperatures and 
pressure, set points and spectroscopic information. This information is generally 
not useful to the user, but can be useful for diagnostic purposes and is stored in 
the following directory: 

/Home/Picarro/I2000/Log/Archive/DataLog_Private 
/[year]/[month]/[day]/[hour] 

The archive files are in a HDF5 format, a more efficient data storing format with an 
.h5 file extension. 
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8.2 Data File Name 
The file name is generated from the analyzer serial number, the date, and the 
time when the file was started. The specific time stamp will depend upon the time 
the instrument was started and began measuring sample gas, so files seldom 
begin exactly at the top of the hour. For example: 

 

Figure 36: Example Data File Name 

• CFADS2101 is the analyzer serial number

• 20210201 is the date, in format yyyymmdd (to allow chronological sorting
of data files).

• 224542 is the time the file was started in the computer’s local time
22:45:42, formatted as hhmmss using a 24-hour clock. Note that the time
stamp of samples within the file is usually recorded in UTC (GMT) relative
to the local time. For example, an analyzer in California will usually have a
time stamp (UTC) within the file that is 8 hours ahead of the time stamp in
the file name itself (UTC - 8).

8.3 File Archiving 
Picarro instruments will not delete data. Some instruments will, however, 
compress and archive older data to conserve hard drive space. Raw data file 
archiving frequency and details can be modified in the file:  

Home/Picarro/I2000/AppConfig/Config/Archiver/Archiver.ini. 

CAUTION 

To avoid losing data, discuss with Picarro support before attempting any 
changes to the Archiver.ini file. 

Instrument Serial 
Number 

Date Time (Local) 

CFADS2101-2021021-224542Z-DataLog_User.dat 
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For each file type, there are various items along with some recommended default 
settings which may vary by file type: 

• Directory = /Home/Picarro/I2000/Log/Archive

Optionally specifies which directory to find files to archive.

• MaxCount = -1

Specifies how many files to keep. A setting of -1 indicates that there is no
maximum number of files. Generally, -1 is used in conjunction with a
maximum size limit, below.

• MaxSize_MB = 1500

Specifies that a maximum of 1.5 GB of data is to be kept before the
system begins to archive old data.

• Compress = True/False

Specifies if archived files are to be zipped – recommended setting is true
to save hard drive space.  True means files are zipped, false means files
are not zipped.

• AggregationCount = 0

If compression is set to TRUE, specifies how many files to be included in
each zip archive.

• StorageMode = FIFO

First in first out. Specifies that old data is archived first.

• Quantum = 4

Generally, should not be changed. Specifies the files be sorted by
year\month\day\hour in the archived directory structure.
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9. Calibration

9.1 Introduction 
Periodic recalibration with standards of known concentration maintains the 
accuracy of your analyzer. Using the Data Recal Software Utility (described in 
section 9.4, Direct Calibration Through the Data Recal Tool (Recommended)) 
enables the calibration constants to be tracked over time, thus enabling the user 
to follow system performance. 

9.2 Slope and Offset 
Every Picarro analyzer ships with a default user calibration value of 1 for 
slope and 0 for offset. While new user calibrations will likely result in changes to 
both, we recommend that only offset changes are applied during more frequent 
calibrations. 

A rule of thumb with Picarro analyzers is that their linearity seldom drifts more 
than 5% in either direction over many years, so a recalibrated slope of <0.95 or 
more than 1.05 typically reflects not instrument drift, but the uncertainty in the 
other components of a calibration, e.g., reference materials, gas delivery, or 
sample handling materials compatibility.  

If during your slope calibration, a new value of 0.9 or 0.85 is suggested by the 
Data Recal tool, please repeat the measurements of your standards, checking for 
any leaks or dilution, confirming regulators are fully flushed before use, and 
confirming that you’ve taken the certified rather than target value on your 
calibration cylinders. In most cases, such large changes in slope are a result of 
these sorts of biasing effects, and do not indicate a lack of repeatability in the 
analyzer. If your analyzer continues to suggest a large change in slope, please 
consult with Picarro Support before applying a new calibration. 

While the user can expect non-reactive gases (including surrogate gases which 
are traceable to primary standards) to be quite repeatable to better than 5% from 
use to use, the same is not always true of reactive gases. Gases like ammonia 
are typically certified with significantly larger uncertainty terms, and standards are 
expected to degrade, often significantly, over months or years. Accordingly, the 
overall health of an analyzer (e.g., laser or sensor drift) should be assessed by the 
non-reactive species reported when high quality reactive gas standards are not 
available or trusted.  
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NOTE 

If you are uncertain about the state of your current slope and offset values, 
they can be reset back to their user default values of 1 and 0, respectively. 
From the Picarro Launch Pad, navigate to Tools and User Calibration. 

Then change the slope and offset values of your parameter of interest to 1 and 
0, respectively. 

9.3 Calibration Methodology 
To perform a calibration or verification of calibration, the user simply introduces 
the calibration standard into the analyzer for a period long enough for the analyzer 
to yield a stable, typically five-minute measurement of that sample. 

WARNING 

When calibrating with hazardous, corrosive, explosive, or otherwise dangerous 
gases, the user should follow best practices for reducing personal exposure, 
including locating the instrument and pump near or in a vacuum hood, and/or 
venting pump exhaust flow into a vacuum hood or dump line 

Calibration Setup 
Connections from the analyzer to the gas tank 

• Always use a two-stage regulator capable of delivering 2-3 PSIG. Picarro
recommends e.g., the Y12ASC445A590-AG Stainless Steel regulator from
Airgas. This regulator offers a 0-30 PSIG range, which requires caution
when directly connecting the instrument and cylinder, but also allows
users the flexibility to use the cylinder with mass flow controllers. Always
ensure the calibration pressure is set carefully before connecting to the
instrument directly, and consider adding a bleed tee to avoid excess
pressure buildup.

• The pressure regulator at the outlet of the gas tank protects the analyzer
from over-pressurizing. The pressure should be set to about 2 – 3 PSIG
(0.14 bar – 0.2 bar).

• The toggle valve allows rapid shutoff of the gas delivery.

• Tubing is connected to the male inlet bulkhead thread on the back with the
analyzer.

• If the user is either moving a regulator from tank to tank, placing a
regulator on a cylinder for the calibration, or calibrating for reactive gases,
they should flush their regulator fully 2-3 times before use. Follow the
tutorial located on the Picarro website Video Gallery. If you are viewing
this manual on PDF, click HERE to go directly to the video. Otherwise,
navigate to the video by following these instructions:

a. In your web browser, enter https://www.picarro.com/, hover
over the Support dropdown and select Document Library. The

https://www.picarro.com/videos/flushing_regulators
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Document Library homepage will open. 

b. Click on the Video button near the top of the page.

c. When the video page opens, click on the Flushing Regulators
link to view the video.

CAUTION 

Failure to flush the regulator fully will typically result in a long, slow stabilization 
process that may take an hour or more for values that differ greatly from ambient 
air, or the gas from a previous tank. 

When switching between tanks: 

1. Ensure you are in a well-ventilated setting, and that all gases are
contained within a fume hood.

2. Disconnect the tubing from the instrument inlet.

3. Turn off the main cylinder valve on the current cylinder.

4. Bleed down the pressure in the regulator using best practices, typically
by disconnecting the line from the regulator to the instrument, and
increasing the delivery pressure until both gauges have dropped to zero.

5. Disconnect the pressure regulator from the tank.

6. Connect the pressure regulator assembly to the next gas tank,

7. Flush the regulator with the new gas, following the instructions
mentioned in the previous section.

8. Set the delivery pressure back to 2-3 PSIG.

9.4 Direct Calibration Through the Data Recal Tool 
(Recommended) 
Data Recal 
The Data Recal software utility is designed to enable users to perform a 
concentration calibration or calibration verification of Picarro’s gas concentration 
analyzer via a user-friendly interface.  

Data Recal allows the input of ten calibration points. Ideally, three concentration-
certified standards, or a single standard blended with diluent air to three 
concentrations, should be used for calibration checks. Standards spanning and 
encompassing the intended sample range should be used to build the standard 
calibration curve. Parameters of this curve will then be used to correct the 
instrument readings to match the standard cylinder values.  
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NOTE 

The following steps illustrate the Data Recal procedure for concentration 
measurements. The user can follow the same steps for isotope measurements, 
if working with a Picarro isotope analyzer. 

Running Calibration Standards for Direct Calibration 
1. With the first standard hooked up to the inlet (typically starting with the

lowest concentration), navigate to the main Picarro GUI, and watch until
the calibration tank values have stabilized. Ensuring that Show
Statistics is selected from the View menu, zoom in on a 5-minute
stable period for a given gas species, and write down in a lab book or
new text file the reported Mean concentration value from the left hand
side of the screen for each species being calibrated.

2. When complete for the first tank, remove the tank from the instrument
inlet and close the cylinder and/or on/off toggle valve.

3. Connect up the next cylinder and repeat the above steps for the
remaining cylinders.

Graphical User Interface (GUI) 
The Picarro Data Recalibration (Data Recal) software is located from the 
Picarro Launch Pad, Tools menu. The Data Recal software is launched by 
clicking User Calibration button and displays as shown in the following figure. 
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Figure 37: Data Recal Software Utility GUI 

The Data Recal Software Utility consists of three sections: 

1. Numerical Input and Selection sections (Figure 38):

Start with the first gas being calibrated, e.g., CO2.

a. Under Certified, enter the certified value for the tank, as
characterized by the manufacturer. Importantly, ensure that you
do not simply enter the target concentration requested upon
purchase. While a tank can occasionally be delivered at exactly
the target concentration, this is very rare. Typically, the certified
value will have more significant figures, e.g., 103.1 ppm, rather
than 100 ppm. The example in the image below is notional, and
thus uses round numbers.

b. Under CRDS reported, enter in the values noted down in a lab
book/text file in the previous section corresponding to each
calibration tank. Be sure to check the Used for Recal checkbox
on the left so that the program knows to use the certified and
CRDS reported values in the calibration curve.



Calibration 

PI2910/PI2920 UM P/N 40-0101 Rev. B 69 

Figure 38: Recalibration Section of Data Recal Software Utility GUI 

2. Calibration Output section (Figure 39):

In the Calibration Options drop-down menu, the user can select either
an Offset or an Offset + Slope.

When using multiple standards, Offset and Slope are appropriate.
Selecting Offset only is appropriate for single point scaling adjustments,
e.g., for re-zeroing an analyzer.

Once the new calibration parameters are calculated, the Data GUI will 
display the new values under the New Calibration column. The 
parameters that appear here will depend on the user’s initial selection. 
When the Offset + Slope option is selected, the program also calculates 
a goodness-of-fit correlation coefficient (R2). 

Figure 39: Calibration Output Section of Data Recal Software Utility GUI 

3. Action Selection section (Figure 40):

In this section, the user can click on the Compute button to calculate the
new calibration parameter(s). The compute button will be grayed out until
values have been entered in the Certified and CRDS reported columns
(Figure 38), and at least one pair of Certified and CRDS reported values

New change Indicator 
(asterisk) 
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selected for the calibration. Once these values are entered or selected, 
the Compute button will be active. Click Compute to calculate the new 
calibration parameters. These parameters will appear in the Calibration 
output section of the GUI, and an asterisk “*” will be displayed at the end 
of the window title line (Figure 38), indicating the new change. 

Figure 40: Action Selection Section of Data Recal Software Utility GUI 

Once the calibration parameters are calculated, the user can elect to 
graphically display the calibration and quality control (QC) standards in a 
graph. To do this, click Plot in the upper left corner of the window, and 
select Plot Linear Fitting from the drop-down menu, as shown in Figure 
41 below. 

Figure 41: Data Recalibration – Plot Linear Fitting 

The plot that the utility will generate is shown in Figure 42; this plot will display two 
graphs. The top graph presents measurements for the recalibrated standards 
(calibration and QC), as well as a line fitting through those points. The bottom 
graph shows the residuals, which shows how far each measurement is from the 
best-fit line. 
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Figure 42: Slope of Data Recalibration 

If the user decides to accept the new calibration values based on this plot, they 
may click on the Apply New Cal button (Figure 43). 

Figure 43: Apply New Calibration Slope and Intercept 
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The user will then be prompted to enter a Calibration Password (Figure 44). The 
default Calibration Password is picarro, all lower case. 

Figure 44: User Authorization Dialog 

Next, a Recalibration Confirmation pop-up window will appear, displaying the 
new offset and slope (when applicable) values. This window will prompt the user 
to confirm their choice to apply these values, to avoid any inadvertent mistakes. 

Figure 45: Calibration Confirmation Pop-up 

When the user clicks the Yes button, the newly accepted calibration parameters 
will take effect immediately, without the need for the instrument main GUI to be 
restarted. 

Once the user accepts the new calibration parameters, the Data Recal Software 
Utility automatically gives them the option to save the new recalibration file 
(Figure 46 below). Saving these files enables the user to track the instrument 
recalibration history.  



Calibration 

PI2910/PI2920 UM P/N 40-0101 Rev. B 73 

Figure 46: Data Recalibration Save-As File Dialog 

The recalibration file for this example would contain the information as shown in 
Figure 47 below. 

Figure 47: Data Recal Log File Example 
Rows 2 – 4: Values from each standard selected for recalibration. The first 
column in these rows lists the certified values, the second column lists the 
measured values, and the third column lists the recalibrated values. The number 
of rows will depend on the number of standards selected to be used for 
recalibration. 

Row 5 – Current Calibration (cc) Row: Read from left to right, lists the current 
offset and current slope value. 

Row 6 – New Calibration (nc) Row: Read from left to right, lists the new offset 
and new slope values. The third value in this row is the R2 value, which is only 
displayed if the calibration option is Offset + Slope. 

Row 7 – Options Row: The last row displays the calibration option selected. 
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If the user chooses to exit the Recal GUI before accepting the new recalibration 
values, they will be prompted to confirm their choice through a pop-up window 
(Figure 48). This window contains a warning that continuing to exit will cause the 
new calibration data to be lost: 

Figure 48: Recalibration Exit Confirmation Pop-up 

When the user is finished with the calibration, they can either click Clear Entries 
at the bottom of the screen, and begin entering values for the next gas species, 
ensuring to select the right variable from the Data Options dropdown, or they can 
exit the Data Recal software utility by clicking on the Exit button. 

Figure 49: Exit Data Recalibration Utility 

NOTE 

The Data Recal will display an error message indicating the new slope value is 
not acceptable when one of the following occurs: 

• At least two entries in the Certified or CRDS reported columns contain
zero-value numbers.

• These entries are selected to be used for recalibration.

• The “Offset + Slope” calibration option is selected. This error occurs
because the entered values will lead to an erroneous zero-slope value.
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Loading a Previous/Stored Calibration 
Saved calibration configurations can also be reloaded by clicking File in the upper 
left corner of the window (Figure 50) and selecting Load Recalibration File. 

Figure 50: Data Recalibration Load File 

From the load file dialogue, the user may select and open the file they wish to 
load (Figure 51).  

Figure 51: Data Recalibration Load File Dialog 
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9.5 Calibration Data Processing (less common, less 
direct option) 

1. The user may process the calibration results from a given .dat file(s)
(see File Management on Page Error! Bookmark not defined.) and
calculate the average recorded value for each standard.

2. Plot these values versus the certified values from the gas supplier, and
determine the linear relationship between the known calibration values
and the analyzer’s reported values. A linear best-fit equation can be
calculated from the data.

NOTE 

It is important to plot the analyzer’s reported concentration on the horizontal 
axis and the gas standards’ stated concentrations on the vertical axis. 

The slope and intercept of the best-fit line through these points are the two values 
that are used to calibrate the analyzer. By determining the linear relationship 
between the known calibration values and the analyzer’s reported concentration 
values in this way, a calibration offset (slope and intercept) can be calculated to 
add a correction term to the analyzer’s factory or previous calibration. 

Entering the Calibration Setting 
Changing the analyzer’s calibration is intended to be done infrequently. Instead of 
recalibrating frequently to increase the accuracy of the data, users often just verify 
the calibration by measuring three or more gas standards and use the same 
regression procedure described here to calculate an offset by which to correct 
their data offline.  

Using the following equation in the graph in Figure 52 below, this calculation 
would be accomplished point-by-point by calculating the corrected data “y” using 
the analyzer’s data “x” so that: 

Datacorrected = 0.9874 × Dataraw + 5.7478 
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Figure 52: Linear Calibration Example 

Calibration values are input into the analyzer by selecting Tools, User 
Calibration from the Picarro Launch Pad, and then entering the slope and 
intercept for each species. 

NOTE 

User Calibration is a password-protected form, and the default password is 
“picarro.” This password can be reset in the QuickGui.ini file as previously 
described. 

The calibration will take effect immediately after clicking OK. 

Returning the Instrument to its Factory Calibration 
To return the instrument to its the factory calibration, within the Calibration Tool, 
simply set the slope to 1 and the intercept to 0 for the desired species. This 
returns the instrument to its factory settings, though this does not ensure that the 
system will read exactly as it did when it left the factory if a small amount of drift 
has accumulated over a period of time. 
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9.6 Detailed Picarro Calibration Guide 
For more detail on calibrating a Picarro analyzer, refer to the Calibration Guide 
for Picarro Analyzers. This document can be downloaded by either clicking the 
link below or entering the URL in a web browser. 

https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-
Rev1.pdf 

https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-Rev1.pdf
https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-Rev1.pdf
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10. Troubleshooting
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution 
in most cases. If, after attempting these procedures, the problem remains unresolved, 
please contact Picarro Customer Service at (408) 962-3990 or support@picarro.com. 

10.1 Power LED on Analyzer Does Not Illuminate 
Context: Turning on the analyzer by momentarily depressing its back panel 
power switch should apply power. The green power LED is illuminated when it 
detects the correct power levels. 

1. Check that the AC power cord is attached and plugged into a working
outlet.

2. Check that the rear on-off switch near the AC power cord is in the ON
position ( I ).

3. Press and hold the front panel power switch for at least 5 seconds as
the analyzer may take several seconds to respond.

10.2 Sample Pressure not Controlled to Appropriate 
Value for Concentration Measurements 

Context: Under normal operation, the cavity pressure is automatically locked to 
the correct value by means of electronically controlled inlet and outlet valves. The 
message “Pressure Locked” on the front panel display and the user interface 
indicates that the cavity pressure is at the appropriate value. Should either of the 
messages “Pressure high” or “Pressure low” be displayed, the cavity pressure is 
out of its correct operating range.  

1. The “Pressure low” message indicates that there is insufficient gas
available at the inlet of the analyzer. Check the inlet plumbing to the
analyzer and ensure that the pressure at the inlet is within the
specifications. Check for blockages in the lines, or regulators that are
turned off, especially by removing all items upstream of the inlet to see if
the pressure returns to the specification. If removing plumbing from
upstream of the instrument inlet doesn’t work, the inlet particulate filter
may need to be replaced. See section 11, Maintenance for more
information.

2. The “Pressure high” message indicates that gas cannot be removed
from the analyzer at a sufficient rate. Check the vacuum line between
the analyzer and the power vacuum unit for leaks. Failure of the vacuum
pump, injecting dilution gas at excessive pressure, or excessive
pressure at the inlet can also cause this problem.
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11. Maintenance
The advanced, rugged design of Picarro Analyzers provides stable, long-term operation 
with minimal service or maintenance. With the exception of the following items, the 
analyzer and pump are not user serviceable. Should either appear to malfunction, 
please refer to the Troubleshooting Guide or contact Picarro Support.  

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store.  

11.1 Service Plans 
In addition to basic telephone and email support and remote diagnostics, service 
plans include an annual preventive maintenance kit and can be purchased by 
contacting sales@picarro.com. The three service plans are as follows: 

• W3101 Essential Service Plan: Free yearly maintenance kit; 50%
discount on Field Replaceable Parts; 10-20% Discounted factory repair.
See data sheet for complete terms and conditions.

• W3102 Premium Service Plan: Free yearly maintenance kit; Extended
warranty; Free factory repair; Free Field Replaceable Parts. See data
sheet for complete terms and conditions.

• W3103 Commercial Service Plan: Free yearly maintenance kit;
Extended warranty; Free factory repair; Free Field Replaceable Parts;
Loaner instrument; Free yearly prevention maintenance visit;
Complimentary remote refresher training. See data sheet for complete
terms and conditions.

11.2 Preventive Maintenance Kits 
Preventive maintenance kits can be purchased by contacting 
support@picarro.com. The maintenance kits include the following elements: 

Replacement CPU Fan; particulate filter (Stainless Steel or Teflon); dust filter; 
replacement screws for instrument cover panels; Ball-Point Hex L-Keys; Anti-
Static Wrist Strap. 

For the P2910 analyzer, Picarro recommends: 

• S3092: Yearly Maintenance Kit for GHG, L2xxx, and EtO

• S3093: Yearly Maintenance Kit for PI2114

• S3094: Yearly Maintenance Kit for HAPs G2xxx User-Replaceable
Hardware

mailto:sales@picarro.com
mailto:support@picarro.com
https://www.picarro.com/support/library/documents/s3092_quick_start_guide_for_ghg_l2xxx_and_eto_analyzers
https://www.picarro.com/support/library/documents/s3094_quick_start_guide_for_haps_hazardous_air_pollutants_and_g2xxx
https://www.picarro.com/support/library/documents/s3094_quick_start_guide_for_haps_hazardous_air_pollutants_and_g2xxx
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11.3 User-replaceable Hardware – Individual 
Components 
Inlet Particulate Filter 
The inlet particulate filter is user-replaceable. Use the following links to order 
replacements and to find an instructional video and supporting maintenance 
document. 

Picarro Store Ordering Links: 

• Stainless Steel Filter: For all models except those that measure HF, NH3,
CH2O, HCl and H2O2

S1020 Particulate Filter Kit – If viewing this manual as a paper hard
copy, enter the following URL in your browser:

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-
except-HF-NH3.html

• Teflon Filter: For models that measure NH3, HF, CH2O, HCl and H2O2

S1021 Particulate Filter Kit – If viewing this manual as a paper hard
copy, enter the following URL in your browser:

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-
HF._3

Filter Replacement Instructional Video and Document: 

• Filter Replacement Instructional Video: https://vimeo.com/375518688

This video covers replacement of both stainless steel and Teflon filters.
Note that this video does not currently cover replacement of externally
mounted particulate filters.

• Filter Replacement Maintenance Guide:
https://www.picarro.com/support/documents/inlet_particulate_filter_mainte
nance_guide

This guide covers replacement of both stainless steel and Teflon filters for
analyzer models that have either internally or externally mounted filters.

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
https://vimeo.com/375518688
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide


Maintenance 

82 P/N 40-0101 Rev. B PI2910/PI2920 UM 

A2000 Pump Rebuild Kit 
The pump rebuild kit is the only component not currently sold as part of a 
preventive maintenance kit because the replacement frequency is not strictly 
annual (frequency depends on pump usage).  

The A2000 pump diaphragms and valves are user-replaceable. Use the following 
link to order rebuild kits and to find the instructional video and supporting 
maintenance document. 

• Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and
Flux analyzers)

S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as
a paper hard copy, enter the following URL in your browser:

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-
vacuum-pump.html

A0702 Pump Rebuild 
The A0702 recirculation pump (if used with your analyzer) is not user 
serviceable. Instead, these pumps may be exchanged once they reach the 
end of their diaphragms’ operational life. Please contact 
support@picarro.com to coordinate this exchange. 

11.4 Cleaning 
Clean the outside of the analyzer with a clean dry cloth. Only certified service 
technicians should access or clean the inside of the analyzer. 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
mailto:support@picarro.com
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12. Transportation and Storage
If the analyzer will be transported or stored, use the following procedure to prepare and 
repack it into the original packaging. 

CAUTION 

When shipping or relocating the analyzer, it is important to protect it from 
mechanical shocks. Failure to do so can compromise its performance. When 
shipping the analyzer, use its original packaging only. 

12.1 Shutdown and Preparation 

CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. See section 5.2, Shutdown for 
specific shutdown instructions for your model analyzer. 

1. Click on the Quit button located on the left side of the Data Viewer
window.

2. A window displays (Figure 53) prompting the user to confirm the
shutdown. Click Yes to continue with the shutdown process.

Figure 53: Stop Data Acquisition/Shutdown 

Confirm the level of water vapor prior to shutdown. Click No, if the 
analyzer was dried before shutdown. Click Yes, if the analyzer requires 
dry gas to reduce the moisture content. 

Once confirmed, the analyzer software and hardware will turn off. 

Figure 54: Reduce Moisture Content/Shutdown 
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3. Manually turn off the pump(s) and dry gas (if used).

4. Disconnect all tubing and electrical connections from the analyzer.

5. To prevent contamination and possible damage to the connector
threads, place protective caps on all gas connections.

12.2 Packing 
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal

the bags with tape. If shipping the pump, do the same for it.

2. Pack the analyzer and pump in the original shipping containers ensuring
that all the foam pieces are in place to protect the analyzer during
shipping.
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APPENDIX A – Setup Tools and 
Communication 

A.1 Picarro Analyzer Settings and Tools
The Picarro Analyzer Setup Tools is accessed by using the Picarro Launch 
Pad and Settings button. These set of tools allow the user to configure data file 
saving details, including which data elements are written to data files, digital data 
output (via serial port or TCP/IP), and optionally configured electrical interface for 
additional measurement monitoring. 

NOTE 

You must be logged in as a technician or administrator to access the Setup 
Tools under Settings. 

The settings of the Setup Tool are explained in the next pages in brief. A more  
in-depth description of the material is provided in the subsequent section. If you 
have any questions about the Setup Tool, please contact Picarro or refer to 
Picarro Community for further details. 

https://www.picarro.com/support/community 

Figure 55: Analyzer Setup Tools 

https://www.picarro.com/support/community
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NOTE 

Before running any of the setup tools, the instrument software must be stopped. 

From the CRDS Data Viewer, select the Quit button and click Yes when 
prompted to stop data acquisition. The Setup Tool options are now active. 

Serial Port 
Configure the ASCII Serial Port by setting the Data Out and Command Interface 
parameters that are used for RS-232 serial communication.  

The following options are provided: 

• Port: Indicates the desired communication port.

• Baudrate: Specifies the rate at which bits are transmitted.

• Data Bits: Specifies the number of data bits to transmit.

• Stop Bits: Specifies the number of bits used to indicate the end of a byte.

• Parity: Indicates the type of parity checking.

• Enable Serial Port: Enables or disables the communication port specified
in the Port field.

After making the appropriate edits, click Save to put changes into effect and then 
OK to close the window. For more information about Serial Communication, see 
Picarro Serial Communication. 
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Figure 56: Serial Port Settings 

Port Manager 
The Port Manager allows you to control digital data output/Input via serial port or 
TCP/IP.  

On this window, you can specify: 

• Data Streaming: The port you want your data to stream through
(COM1/COM2/Off)

• Valve Sequencer MPV (Multi Position Valve): The port you want to
connect your MPV to (COM1/COM2/Off)

For more information on the configuring for external valves, see
APPENDIX E – External Valve Sequencer.

• Command Interface: (COM1/COM2/TCP/Off).

Make sure there are no COM port conflicts before clicking Save.

After making the appropriate edits, click Save to put changes into effect and then 
OK to close the window. 
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Figure 57: Serial/Socket Port Manager Settings 

Command Interface – Specifying Digital Data Output 
The Command Interface allows you to specify the data elements that are sent 
via COM port/TCP (specified in the Port Manager). Two types of data can be 
specified here:  

Output Data Source: 

• Datalog_User

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers).

Output Data Columns: 

• The data columns are output in the order they are checked, e.g., CH4,
comes before CO2. Command Interface enables an external device to
send a set of predetermined commands to a Picarro analyzer. The Picarro
returns data or metadata on the basis of the command received.

After making the appropriate edits, click Save to put changes into effect and then 
Exit to close the window. 
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Figure 58: Command Interface Settings 

Data Streaming – Specifying Digital Data Output 
The Data Streaming allows you to specify the data elements that you want to 
send via COM port (specified from the Port Manager). Two types of data can be 
specified here:  

Output Data Source: 

• Datalog_User

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers).

Output Data Columns: 

The data columns are output in the order they are checked, e.g., CH4, comes 
before CO2. Command Interface enables an external device to send a set of 
predetermined commands to a Picarro analyzer. The Picarro returns data or 
metadata on the basis of the command received. 

Data Streaming outputs data continuously, whereas the Command Interface 
needs commands to output data. 

After making the appropriate edits, click Save to put changes into effect and then 
OK to close the window. 
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Figure 59: Data Streaming Settings 

Electrical Interface – Customizing Analog Output Channels 
The Picarro analyzer may be optionally configured with an Electrical Interface 
Card (EIC) that provides up to 8 analog signals available to the user for 
monitoring various measurements results and analyzer parameters. 

The Electrical Interface allows you to customize each analog output channel. 

After making the appropriate edits, click Save to put changes into effect and then 
OK to close the window. 

NOTE 

This window will be disabled if your analyzer was not configured to work with an 
analog peripheral. 
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Figure 60: Electrical Interface Settings 

Data Logger 
The Data Logger allows the user to configure various data file saving details, 
including which data elements are written to data files.   

• Data Columns: Controls which data elements are written to data files.

• Hours of Each Log File: Controls the size of each data document.

• Enable Mailbox Archiving: Enables archiving of data in the mailbox
folder – /Home/Picarro/I2000/Log/Archive/DataLog_Mailbox

• Archived Directory Structure: Specifies part of naming convention for
data documents.

• Total User Log Storage Size (GB): Specifies the size of storage allowed
for User Data (Recent Data).

• Mode: Changes the way the analyzer fits and displays data in the data
viewer on the basis of gas matrix, species reported, precision, and
dynamic range.

After making the appropriate edits, click Save to put changes into effect and then 
OK to close the window. 
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Figure 61: Data Logger Setup Settings 

A.2 Picarro Serial Communication
The analyzer supports an RS-232 physical command interface, which can be 
used to control the instrument and to retrieve concentration data. Not all features 
of the instrument are available on the serial interface.  

For details on using the serial command interface, please see the Picarro 
Analyzer Remote Interface Programming Guide. 

To Download: 

1. Go to https://www.picarro.com/.

2. Under the Support tab (near the home page upper-right corner), select
Document Library.

NOTE 

Registration/Login Required: Access to online User Manuals is available to all 
registered Picarro customers with login credentials. If you do not yet have an 
account, please email us at support@picarro.com to request access to the 
document library. 

3. When the Document Library page opens, enter the search terms,
“Remote Interface” in the Search field.

https://www.picarro.com/
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4. In the results, click on the link titled “Remote Interface Programming
Guide 40-0063” to open the manual in your browser. From there you
can also download and save it to your PC.

This command set may also be used across a TCP/IP interface through an 
Ethernet connection. Please contact Picarro for further details if needed. 

Remote Data Access 
Using the RemoteAccess.ini file, the analyzer can be configured to automatically: 

• Send data from the instrument to a list of e-mail accounts.

• Measure the offset of the host computer system clock from a set of
Internet time servers and (optionally) to resynchronize the clock based on
this information.

The Internet connection need not be permanent and may be a dial-up connection 
accessible via a user-supplied USB modem. The task of sending data and/or 
synchronizing the clock on the analyzer is performed using the 
/Home/Picarro/I2000/HostExe/RemoteAccess.exe program.  

Each time that the RemoteAccess.exe program runs, it appends information to a 
log file, which keeps a record of the results of the time synchronization and of the 
files sent by e-mail. The RemoteAccess.exe program is configurable by means of 
an initialization file, which includes information such as the login credentials for 
the dial-up connection, the e-mail account, and the list of time servers. 

The initialization file is: 

/Home/Picarro/I2000/AppConfig/Config/UtilitiesRemoteAccess/RemoteAccess.ini 

It should be placed in the same directory as the executable RemoteAccess.exe. 
The file has one required section named LOGGING and optional sections named 
NTP and EMAIL. The logging section has a single key Logfile whose value is the 
path to the log file. Once this log file exceeds 64 Kbytes in length, it is backed up, 
appending a numeric extension to the file name, and a new file is opened. A total 
of ten backup log files are kept. 

NTP 
The NTP section controls querying the Internet time servers using the SNTP 
protocol (RFC4330) and the resetting of the clock on the host computer. If the 
section is not present, time synchronization is not carried out. The keys Server1, 
Server2, etc., are used to specify the URLs of the time servers. If the UpdateClock 
key is set to “true,” the offset is applied to the host clock. Otherwise, the offset is 
recorded, but the host clock is not changed. 



Setup Tools and Communication 

94 P/N 40-0101 Rev. B PI2910/PI2920 UM 

Email 
The EMAIL section controls the sending of the data files as e-mail attachments. If 
the section is not present, e-mail messages are not sent. The key Directory 
specifies the directory that contains the data files. When the program is run, files 
in this directory are sent to the specified recipients and the files are deleted. To 
avoid problems with incomplete files, programs that place files into this directory 
should do so using an atomic operation, such as a rename. The Server key is set 
to the name of an RFC2821- compliant SMTP server that sends the e-mail 
messages. 

The From key is the e-mail address from which the messages are sent. Note that 
some SMTP servers check that the source is permitted to send email while others 
allow any name in this field. The collection of e-mail addresses to which copies of 
the e-mail is sent is specified by the keys To1, To2, etc. The Subject key is used 
to fill the subject field in the email header and may be set to any string. Depending 
on the SMTP server, it may be necessary to use authentication before e-mails can 
be sent, as described in RFC2554. If such authentication is not needed, the key 
UseAuthentication is set to false. If this key is set to true, two additional keys 
Username and Password must also be specified for the e-mail account. 
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APPENDIX B – Modbus Communication 

B.1 Enabling Modbus
To utilize Modbus as a communication protocol it must first be enabled from the 
Picarro Launch Pad through the Administration menu and using the Toggle 
Modbus button.  

NOTE 

This requires you to be logged in as an administrator. If you do not have 
administrator privileges, contact your admin to enable the Modbus option. 

Use the following procedure to enable the Modbus button. 

1. Login as administrator and click Settings and Toggle Modbus.

Figure 62: Toggle Modbus 

2. Click OK to enable Modbus.

Figure 63: Enable Modbus 
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3. Restart the system.

After restarting the system with the Toggle Modbus option enabled the
Modbus button in the Settings menu becomes active and allows for
configuration of the Modbus server (Figure 63).

Modbus Enabled on Configuration Screen (Settings menu) 

Modbus Disabled on Configuration Screen (Settings menu) 

*If the Modbus button does not appear on the configuration screen, it means that feature has
not been enabled.
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Figure 64: Analyzer Configuration Screen for Modbus Access 

B.2 Configuring for Modbus Communication
1. From the Settings menu, click the Modbus button to configure the

Modbus server as shown in Figure 64.

Figure 65: Settings/Modbus Configuration 

NOTE 

If a Modbus button does not appear in the Configuration menu, then Modbus 
communications must be enabled before Modbus can be configured. For more 
information, See the previous section Appendix B.1 Enabling Modbus. 

This displays the Modbus Settings window shown in Figure 65. From the 
Modbus Settings window the following configuration options are available: 

• The analyzer’s Slave ID

• Modbus Communication Protocol: TCP/IP or RTU (For more
information and notes, see Section B.2, Modbus Data Registers
Overview and Setup.)

• TCP Port designation (if TCP/IP is selected)

Additionally, the window displays the CommandInterface Status. 
However, if Modbus Type is set to “RTU”, then the CommandInterface on 
COM 1 is disabled. 
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Figure 66: Modbus Settings Window 

B.3 Modbus Data Registers Overview and Setup
This section describes the basic types of MODBUS data registers and setup 
information.  

Table 8: MODBUS Register Types 

Name Size Access 

Input Register 16 bits Read-only 

Holding Register 16 bits Read-write 

Discrete Input 1 bit Read-only 

Coils 1 bit Read-write 
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Setup Notes for Modbus TCP 
• MODBUS is configured for TCP/IP on port 50500.

• When MODBUS is configured on port 50500, communication is also
possible via port 502.

• If MODBUS is configured as TCP/IP and the IP address of analyzer is
changed, the user needs to restart the Host application to run MODBUS
with the updated IP address.

• MODBUS over TCP/IP will not support privileged ports (0 to 1023), except
for port 502.

Setup Notes for Modbus RTU 
• MODBUS RTU uses the analyzer’s COM1 port.

• To establish connection between Master and Slave over MODBUS RTU,
user needs to establish connection using "Straight Through Cable”.

• When MODBUS is configured for RTU, CommandInterface on COM1 will
be disabled.

B.4 Modbus Register Maps Overview
• Data returned is in big endian format if it utilizes more than one Modbus

register.

• If input register functionality is not available for a given analyzer type, the
instrument will return value as “NaN” for float values and “False” for 1-bit
registers.

• Memory map is continuous memory. If a user tries to read a register
address for which functionality is not available, it will return “0”. For
example, reading address 0 for coil registers will return “0” since the
address does not exist.

• If a user tries to read a register address outside of maximum register
memory map, the request will return an exception. For example, reading
address 156 for coil register will return exception code “0x02” (Illegal
address).

• System time is in "milliseconds Since 0001-01-01 AD".
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B.5 Input Register Map
Most of the readings in Picarro analyzer are the float type and need 32-bit data. 
Each parameter utilizes 2 registers, out of which the first one will be storing MSB 
and the second one will be storing the LSB of the float number.   

NOTE 

All entries are floats unless otherwise noted. 

Table 9: Input Registers 

Address Description Units Type Comments 

1-6 Time stamp String Long value return as 12byte 
string. Date will be in format 
YYMMDDHHMMSS 

7-8 EtO 
Concentration  

ppb Float 

9-10 EtO_ID unitless Float Gas ID code 19 identifies gas at 
register 7 as EtO 

11-12 EtO, 30sec 
trailing average 

ppb Float 

13-14 EtO, 2min trailing 
average  

ppb Float 

15-16 EtO, 5min trailing 
average  

ppb Float 

17-18 EtO, max (full 
scale range)  

ppb Float Value is 100,000 ppb or 100 
ppm  

19-20 EtO, min  ppb Float Value set to 0  

21-22 Concentration 
CH4  

ppb Float 

23-24 CH4_ID unitless Float Gas ID code 04 identifies gas at 
register 21 as CH4 

25-26 CH4, 30 sec 
trailing average 

ppb Float 

27-28 CH4, 2min trailing 
average  

ppb Float 

29-30 CH4, 5min trailing 
average  

ppb Float 
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Address Description Units Type Comments 

31-32 CH4, max (full 
scale range)  

ppm Float Value is set at 200 ppm 

33-34 CH4, min  ppm Float Value is set to 0 

35-36 Concentration of 
H20 

% Float Water is measured in absolute 
%, not to be confused with 
relative humidity 

37-38 H2O_ID unitless Float Gas ID code 00 identifies gas at 
register 35 as H2O 

39-40 H2O, 30sec 
trailing average 

ppm Float 

41-42 H2O, 2min 
trailing average 

ppm Float 

43-44 H2O, 5min 
trailing average 

% Float 

45-46 H2O, max (full 
scale range)  

ppm Float Value is 50,000 (5%) 

47-48 H2O, min  ppm Float Value is set at 0 

63-64
Concentration of 
CO2 ppm 

Float 

65-66 CO2_ID unitless 
Float Gas ID code 03 identifies gas at 

register 63 as O2 

67-68
CO2, 30sec 
trailing average ppm 

Float 

69-70
CO2, 2min 
trailing average ppm 

Float 

71-72
CO2, 5min 
trailing average 

ppm Float 

73-74
CO2, max (full 
scale range)  

ppm Float Value is 1000 ppm 

75-76 CO2, min  ppm Float Value set to 0  

77-78 Reserved 

79-80 Reserved 

81-82 Reserved 

83-84 Reserved 
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Address Description Units Type Comments 

85-86 Reserved 

87-88 Reserved 

89-90 Reserved 

91-92 Reserved 

93-94 Reserved 

95-96 Reserved 

97-98 Reserved 

99-100 Reserved 

101-102 Reserved 

103-104 Reserved 

105-106 Reserved 

107-108 Reserved 

109-110 Reserved 

111-112 Reserved 

113-114 Reserved 

115+116 Reserved 

117-118 Reserved 

201-202 Cavity Pressure Torr Float 

203-204 Cavity 
Temperature 

deg C Float 

205-206 DAS 
Temperature 

deg C Float 

207-208 Etalon 
Temperature 

deg C Float 

209-210 Warm Box 
Temperature 

deg C Float 

211-212 Outlet Valve dig 
counts 

Float 

213-214 Instrument cal 
slope, EtO 

Float 

215-216 Instrument cal 
offset, EtO 

Float 
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Address Description Units Type Comments 

217-218 User cal slope, 
EtO 

Float 

219-220 User cal offset, 
EtO 

Float 

221-222 Instrument cal 
slope, CH4  

Float 

223-224 Instrument cal 
offset, CH4 

Float 

225-226 User cal slope, 
CH4 

Float 

227-228 User cal offset, 
CH4 

Float 

229-230 Instrument cal 
slope, H2O  

Float 

231-232 Instrument cal 
offset, H2O  

Float 

233-234 User cal slope, 
H2O  

Float 

235-236 User cal offset, 
H2O 

Float 

245-246 Instrument cal 
slope, CO2  

Float 

247-248 Instrument cal 
offset, CO2  

Float 

249-250 User cal slope, 
CO2 

Float 

251-252 User cal offset, 
CO2 

Float 

253-254 Reserved 

255-256 Reserved 

257-258 Reserved 

259-260 Reserved 

261-262 Reserved 

263-264 Reserved 

265-266 Reserved 
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Address Description Units Type Comments 

267-268 Reserved 

269-270 Reserved 

271-272 Reserved 

273-274 Reserved 

275-276 Reserved 
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Address Description Type Comments 

386 Error Code Integer 
16 

Error for each control command of COIL 
• NO_ERROR = 0
• ERROR_HANDLER_ERROR = 1
• ERROR = 2
• NO_SUDO_USER_PRIVILEGE = 3
• NO_USER_EXIST = 7
• USERNAME_PASSWORD_INCORRECT

= 9
• USER_DISABLED = 10
• ADMIN_RIGHT_REQUIRES = 11
• PASSWORD_LENGTH_ERROR = 12
• PASSWORD_FORMATE_ERROR = 13
• PASSWORD_REUSE_ERROR = 14

387 Measurement Status Integer 
16 

ledState = 0 red, system error, gas conc. 
measurements invalid 

ledState = 1 solid yellow, need service, gas conc. 
measurements might be ok 

ledState = 2 blinking yellow, not in reporting 
mode by system ok, like during warmup 

ledState = 3 green, system ok, gas conc. 
measurements accurate 

388 baselineValueZeroed Integer 

390 ALARM_WORD_1 Float 

392 InletValve Float 

394 ST_STATUS Float 

396 interval Float 

398 flaserc10_90range Float 

400 Laser_T1_offset Float 
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B.6 Discrete Input Register Map

NOTE 

All entries are floats unless otherwise noted. 

Table 10: Discrete Input Registers 

Address Description 

1 Master System Status 

6 Pressure locked 

7 Cavity temperature locked 

8 Warm box temperature locked 

73 Incomplete EtO Spectrum 

74 Incomplete CH4 Spectrum 

75 Reserved 

76 Reserved 

77 Reserved 

78 Reserved 

79 Reserved 

80 Reserved 

81 Bad EtO Baseline 

82 Bad CH4 Baseline 

83 Reserved 

84 Reserved 

85 Reserved 

86 Reserved 

87 Reserved 

88 Reserved 

89 Reserved 

90 Reserved 

91 Reserved 

92 Reserved 
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Address Description 

93 Reserved 

94 Reserved 

95 Reserved 

96 Reserved 

B.6 Holding Register Map
Table 11: Holding Registers 

Address Description Type Comments 

1-4 System time Integer Integer representing milliseconds 
from 1AD January 1st to now 

5-8 User Name String 

9-12 Password String 

201-202 User data 1 Float 

203-204 User data 2 Float 

205-206 User data 3 Float 

207-208 User data 4 Float 

209-210 User data 5 Float 

211-212 User data 6 Float 

213-214 User data 7 Float 

215-216 User data 8 Float 

217-218 User data 9 Float 

219-220 User data 10 Float 

221-222 User data 11 Float 

223-224 User data 12 Float 

225-226 User data 13 Float 

227-228 User data 14 Float 

229-230 User data 15 Float 

231-232 User data 16 Float 

233-234 User data 17 Float 
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Address Description Type Comments 

235-236 User data 18 Float 

237-238 User data 19 Float 

239-240 User data 20 Float 

B.7 Coil Register Map
Table 12: Coil Register Map 

Address Description Comments 

115 Shutdown Host Writing to this bit register will park the 
instrument. 

116 Quit host application 

117 Shutdown Instrument Writing to this bit register will park the 
instrument and shutdown the analyzer. 

151 Get system time After this please read Sync Time holding 
register 

152 User login (Coming in 
near future) 

Before executing this command, user 
needs to set user name and user 
password holding register 

155 Update user password 
(Coming in near future) 

Before executing this command follow 
the steps below: 

1. Login as admin using User Login
functionality if not logged in already.

2. Set user name and password
holding register.

156 User logout (Coming in 
near future) 

201 Get User data 1 

202 Set User data 1 

203 Get User data 2 

204 Set User data 2 

205 Get User data 3 

206 Set User data 3 

207 Get User data 4 

208 Set User data 4 
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Address Description Comments 

209 Get User data 5 

210 Set User data 5 

211 Get User data 6 

212 Set User data 6 

213 Get User data 7 

214 Set User data 7 

215 Get User data 8 

216 Set User data 8 

217 Get User data 9 

218 Set User data 9 

219 Get User data 10 

220 Set User data 10 

221 Get User data 11 

222 Set User data 11 

223 Get User data 12 

224 Set User data 12 

225 Get User data 13 

226 Set User data 13 

227 Get User data 14 

228 Set User data 14 

229 Get User data 15 

230 Set User data 15 

231 Get User data 16 

232 Set User data 16 

233 Get User data 17 

234 Set User data 17 

235 Get User data 18 

236 Set User data 18 

237 Get User data 19 

238 Set User data 19 
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Address Description Comments 

239 Get User data 20 

240 Set User data 20 

NOTE 

• Data is in big-endian format if it utilizes more than one Modbus register.
• If input register functionality is not available for analyzer type, analyzer

will return value as NaN for float values.
• Registers in Red are coming in near future.
• Memory map is continuous memory, so if user try to read address for

which functionality is not available it will return 0 (for example reading
address 0 for coil register).

• If user tries to read address outside of maximum register memory map,
request will be exception (for example reading address 156 for coil
register).

B.8 Gas ID Map
The Gas ID input registers return a two-digit code to identify the gas species being 
measured.  

Table 13: Gas ID Map 

Address Species Description 

00 H2O Water 

03 CO2 Carbon dioxide 

04 CH4 Methane 

19 C2H4O Ethylene Oxide 



Data File Viewer 

PI2910/PI2920 UM P/N 40-0101 Rev. B 111 

APPENDIX C – Data File Viewer 

C.1 Quick Start Guide
The following sections introduce the user to all possible functionalities of the Data 
File Viewer in detail. This section describes the most common, simple use case. 

The Data File Viewer software allows the user to concatenate multiple one-hour 
files into one larger file, enabling the user to observe trends over several days of 
measurements. 

1. To start, translate the UserData files from DAT to H5. The Batch Convert
option (B) allows user s to select any folder containing instrument data
from a given day.

Figure 56: Batch Convert DAT to H5 – Navigation 

2. In the source folder there are now copies of the original files translated
into the H5 format.

3. From File menu select Concatenate H5 Files (C) to combine the H5
files into a time series. Take care to select exactly the same folder in the
file viewer window.

4. In the Select Variables window, click All to move over all variables for
concatenation. If concatenating large records, the user can instead
select only a few variables by clicking the variable name on the left
dialogue, and clicking the double arrow button. Confirm by clicking OK.
().
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Figure 57: Selecting Variables for Concatenation 

5. The user will then be asked to confirm the file name for the
concatenated data. The default location is the parent folder for the
selected day, and the filename by default describes the time span of the
measurements within. Successful concatenation is indicated by the
filename automatically being displayed in the main data file viewer
window as shown in Figure 59.

Figure 67: Concatenated Output .h5 Filename 
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NOTE 

You can concatenate several days into one larger file, either by following steps 
1-3 for selected folders, or by copying all their DAT files into a new folder and 
performing steps 1-5 just once. 

6. With the file now opened, the user can select how many Time Series to
display on the screen.

Figure 68: Time Series Selection Options 

7. In the new window that displays, select the variables from the Var Name
dropdown on the right of each plot. Deselect Autoscale y if the data
stream has a large amount of variability in the Y-axis.

8. Please read the following sections to learn more about features of the
Data File Viewer.

C.2 Data File Viewer Overview
The Picarro Data File Viewer software is located from the Picarro Launch Pad,  
Home menu. This software allows you to graph and to conduct statistical analysis 
of the raw data. Additional functions include Allan Variance plot and quadratic or 
polynomial fittings. The Picarro Data File Viewer includes two main menus: File 
and New (Figure 68).  

Figure 69: Picarro Data File Viewer – File and New Menus 
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C.3 File Menu
This section describes the functions available from the Data File Viewer File 
menu. 

Open File 
File > Open File: Opens a Picarro data file (HDF5 format) for data analysis and 
visualization. After opening the data file, you can create a new time series plot. 
Refer to section C.4, New – Time Series Plot for more information. 

Load Config 
File > Load Config: Loads a configuration file (ini format) to restore parameters 
of a workplace. Refer to Save Configuration for more information. 

Unpack Zip File 
File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a 
single H5 file. Refer to Concatenate H5 Files below for details. 

Concatenate H5 Files 
File > Concatenate H5 Files: Use to concatenate multiple files and zip archives 
of H5 files into a single H5 file. Navigate to the desired folder or use the Define 
Date Range button to specify a date range of files to concatenate. (See next 
section.) 

After selecting the path of the data files, Data File Viewer will automatically search 
an H5 file in the specified zip/folder and look for all available variables in the H5 
file. The variables are then listed in the Select Variables window in the left panel 
(as shown in Figure 69), and users can use the >> button to move variables to the 
right panel for concatenation.  
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Note: this screenshot is for example only. The species selections shown on your analyzer 
may vary.  

Figure 70: Select Variables Form 

Define Date Range 
Data File Viewer can search data files within the desired date range and then 
concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were taken 
elsewhere, select the time zone where data was taken. 
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Select File > Concatenate H5 Files, and click Define Date Range to specify the 
desired date range as shown in Figure 70.  

Figure 71: Define Date Range Dialog 

Picarro software saves data in directories that are named by the creation year, 
month, and day as shown in Figure 703. Select Data files are saved in directory 
trees named by date and time option if the target folder has this file structure. 
This allows Data File Viewer to only search folders within the desired date range, 
which can substantially reduce processing time.  

Figure 72: File Structure of Data File Viewer 
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NOTE 

To save processing time, Data File Viewer does not open data files, but only 
determines data acquisition time based on the file name. 

CAUTION 

Do not define a time range for data files whose names have been changed. 

NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range, so the resulting dataset normally has a wider time range 
than the user specification. 

Convert DAT to H5 
Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. 
These formats are described below: 

• DAT Format: DAT files accepted by DatViewer store tabular data
(numbers and text) in plain text.

o Each line of the file is a data record. Each record consists of one or
more fields separated by whitespaces.

o The first line of the data file indicates column names.

o There must be a field “EPOCH_TIME” to store the acquisition epoch
time (expressed as seconds since Jan 1, 1970) of the data. Otherwise,
the first and second fields must be “DATE” and “TIME”. The “DATE”
field must have the format “mm/dd/yyyy” or “yyyy-mm-dd”, and the
“TIME” field must have the format “HH:MM:SS(.sss)” where (.sss) is an
optional fraction of seconds.

• HDF5 Format: HDF5 is a data model, library, and file format for storing
and managing data. (See the HDF5 Home Page on the HDF Group
website https://www.hdfgroup.org/ for more information.) When converting
DAT to HDF5 format, Data File Viewer creates a table named “results” to
the contained data.

https://www.hdfgroup.org/
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Convert H5 to DAT 
Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. 
These formats are described in Convert DAT to H5. 

NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range.  

Interpolation 
Interpolation describes the method for constructing data points with a range of a 
discrete set of known data points. Select File > Interpolation to perform 
interpolation on a time grid with a constant interval. 

Block Average 
Select File > Block Average to divide a dataset into small blocks based on a 
user-defined block size. The average is calculated for data in each block, and the 
results are saved in a new H5 file. 

NOTE 

The specified block size must be greater than the average data interval. 

Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the block 
size is comparable to the average data interval. 
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C.4 New – Time Series Plot
You can specify to include create time-series plots with one, two, or three frames. 
New plots display in the Time Series Viewer.  

Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 73: Time Series Viewer 

The next section describes the options available on the Time Series Viewer 
menu bar. Refer to The Time Series Viewer Canvas or more information on the 
Time Series Viewer UI features and options. 

C.5 Time Series Viewer Menus
The Time Series Viewer form includes the following menus: 

Figure 74: Time Series Viewer Menus 
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Time Series Viewer File Menu 
Use the File menu to save a configuration or take a screenshot. 

Figure 75: Time Series Viewer – File Menu 

Save Configuration 
Click File > Save Configuration to open the Feature Capture form. With this 
form, you can save figure properties, expressions, filters, and other settings to a 
configuration file so that it can be easily loaded in the future.  

Figure 76: Time Series Viewer – Feature Capture 

CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 
loaded. 

Depending on the features captured, loading a configuration file can have different 
effects. For example: 

• If all features are captured, a saved workplace is reproduced.

• If a data file is not captured, saved parameters are applied to the data file
in memory.

• If an expression is not captured, plots will not be transformed.

• If X (Y) range is not captured, figures are auto-scaled on the x (y) axis.

Take Screenshot 
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and 
save it as a .png to a specified file. 
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Time Series Viewer Analysis Menu 
Use the Analysis menu to calculate statistics, generate a histogram, and to plot 
correlations and Allan Standard deviations.  

Figure 77: Time Series Viewer – Analysis Menu 

Statistics 
Use Analysis > Statistics to calculate mean, standard deviation, and peak to 
peak for all plots in the current window. 

Histogram 
Use Analysis > Histogram to generate a histogram of data as shown in Figure 
77 below.  

Figure 78: Histogram Window – CH4 
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Histogram Window Features 

• Red Line: A Gaussian function fitted to the histogram. Fitting results of μ
and σ are shown in the top-left corner of the plot.

• Bin: Specifies the number of intervals that the range of values is divided
into.

• Normalized: When selected, the sum of the histograms is normalized
to 1.

• Save data: Saves histogram data to a CSV file.

• Save image: Saves the histogram image as a JPEG/PNG/PDF file.

Correlation Plot 
Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in 
the other. This can be used when two or more frames exist in the current Time 
Series Plot window. See the section, Correlation Plot on Page 122 for details. 

Allan Standard Deviation Plot 
Use Analysis > Allan Standard Deviation Plot to create an Allan Standard 
Deviation plot (versus a standard deviation plot) for data in the current window. 
See Allan Variance Wikipedia page for more information. 

Time Series Viewer View Menu 
Use the View menu to view X-axis information in date-time, minute, or hour 
format.  

Figure 79: Time Series Viewer – View Menu 

NOTE 

When switching from Datetime to Minute or Hour, the X-axis data is subtracted 
from the earliest point shown in the panel and then converted to the desired 
unit. 

The Time Series Viewer Canvas 
The Time Series Viewer canvas (Figure 79 below) is comprised of interactive 
graphs and a variety of configuration options. 

https://en.wikipedia.org/wiki/Allan_variance
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Mouse Options and Graph Transform 
The following mouse actions can be used in the canvas graphs: 

• Left-click and drag: Zooms into the selected area of the plot.

• Left-click and drag with the SHIFT key down: Pans the plot.

• Left-click and drag with CTRL key down: Zooms out from the plot.

• Left-click and drag with ALT key down: Stretches the plot.

• Right-click: Opens an additional menu. Refer to the Right-click menu
below in the next section.

Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 80: Time Series Viewer Canvas 

Right-click Menu 
Right-clicking on the canvas opens a pop-up menu: 

Figure 81: Canvas Right-click Pop-up Menu 



Data File Viewer 

124 P/N 40-0101 Rev. B PI2910/PI2920 UM 

Export Image: Exports the current plot as a jpeg, png, or pdf file. 

Export Data in Current View: Exports only date/time and the selected variable in 
the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of the 
selected dataset in the current time range to an HDF5 file. Refer to Concatenate 
H5 Files on Page 81 for more information. 

Edit Plot properties: Opens the Image Editor form ( below), where the following 
options can be specified. 

Figure 82: Image Editor Form 

Image Editor Form Options: 

• Title: Edits the title of the plot.

• Line: Specifies the line pattern of the plot. If None is selected, the data
points will be plotted without connecting lines.

• Marker: Specifies the marker type to indicate data points. If None is
selected, data points will not be shown.

• x-Axis: Min and Max: Specifies the minimum and maximum date range
for the X-axis.

• x[0]: Sets the earliest time of the dataset as the minimum of the X-axis.

• Time zone: Sets the time zone for date/time variables. This defaults to the
local time zone.

• Label: Specify labels for the X-axis and the Y-axis.

• y-Axis: Min and Max: Specifies the minimum and maximum of data
displayed on the Y-axis.
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Dataset Name and Var Name 
An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down (Figure 82) to select the dataset that is used 
for this time series graph. Use the Var name drop down to select the column in 
the dataset to use in the graph. 

Figure 83: Time Series Viewer Dataset Options 

Autoscale Y 
When the Autoscale Y option is selected, the Time Series Viewer will autoscale 
on the Y-axis to make sure that all data within the range of the X axis is displayed. 
This feature can make it hard to see small signals when large signals blow the Y 
axis out, so it is often advisable to deselect this checkbox for dynamic or spikey 
datasets. 

Average 
If Block is selected, a block average is calculated when you click the Do average 
button. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a moving 
average, Size specifies subset size in unit of data points.  

REMINDER 

Averaging is performed after the Filter and Expression are performed. 
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Mean, Std Dev, and Peak to Peak 
The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 82) 
provide all the statistical information of data in the current view. 

Correlation/XY Plot 
The Correlation/XY Plot window (Figure 83) includes two menu items: File and 
Analysis. For details about the File menu, see Save Configuration and Take 
Screenshot on page 121. 

REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, see The 
Time Series Viewer Canvas on Page 122. 

Figure 84: Correlation XY Plot 
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Fitting Menu 
The Fitting menu (Figure 85) includes three options: Fitting, Integration, and 
Statistics. 

Figure 85: Fitting Menu 

Fitting allows you to specify one of four fitting methods to include in the 
Correlation/XY plot: 

• Linear Fit: Specifies to fit to linear function:

y = c1x + c0

• Quadratic Fit: Specifies to fit to quadratic function:

y = c2x2 + c1x + c0

• Polynomial Fit: Specifies to fit polynomial function of degree n:

y = Σcnxn

• Curve Fit: Specifies to use non-linear least squares to fit an arbitrary
function to data.

Analysis Menu 
The Analysis menu has two options: Integration and Statistics. 

Figure 86: Analysis Menu 

• Integration: Calculates area under the curve using the composite
trapezoidal rule.

• Statistics: Calculates mean, standard deviation, and peak to peak for
data in the current view.
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After applying any of the above Analysis options, the results, statistics, or fitting 
function with coefficients are displayed in the lower portion of the Correlation Plot 
window (Figure 86).  

Figure 87: Results of Quadratic Fitting 
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APPENDIX D – Setting up Contained 
Exhaust Flow 

D.1 Introduction
The A2000 vacuum pump is shipped with a noise dampener attached to the 
exhaust port. When a hazardous gas exhaust line from the pump is needed, it 
requires replacing the noise dampener with an adapter that allows a 1/4” OD 
exhaust tubing connection. Use the following instructions if installing a pump 
exhaust line. 

Figure 88: A2000 Pump Vacuum and Exhaust Ports 

D.2 Tools and Parts Required
• Long flathead screwdriver (6” x 5/16” recommended)

• 9/16” open end wrench

• Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN
22928)

• Swagelok gasket SS-2-RS-2V (Picarro PN 22929)

• 1/4" tubing and stainless-steel ferrule set

• Snoop leak-detection fluid or similar soap solution

Vacuum Port 

Exhaust Port with Noise Dampener 
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D.3 Directions
1. Remove the noise dampener fitting from the bottom of the pump using a

long flathead screwdriver (Figure 88).

Figure 89: Pump Noise Dampener Removal 

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928
(Figure 89), screw it into the pump exhaust port, and then tighten it 1/4
turn using a 9/16” wrench.

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure
their orientation is as shown below, then loosely reattach to the adapter.

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the
tubing is fully seated, then using a 9/16" wrench, tighten the nut
approximately seven flats (420 degrees).

A guide to this process can be found on the Picarro Video Gallery here:
https://mktg.picarro.com/acton/media/39674/picarro-video-gallery

Figure 90: Pump Exhaust Line Adapter Fittings 

5. With the pump running on room air, apply Snoop leak detection fluid to
the installed exhaust components to confirm that the system is leak
tight. Instructions for leak testing using Snoop can be found in this
video:

https://vimeo.com/375518688 (go to time 5:20 in the video)

Adapter Fitting 
PN 22928 

Adapter Gasket 
PN 22929 

Ferule 
Orientation 

Noise Dampener 

https://vimeo.com/375518688
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APPENDIX E – External Valve Sequencer 

E.1 Introduction
The Picarro analyzer can control two types of valves: 

• Rotary Selector Valve: Digitally controlled valve used to send selected
flow from one of many inputs (up to 16) into the analyzer.

• Solenoid Valve(s): DC voltage powered valve with normally open (NO)
and normally closed (NC) positions. These can be 2-way or 3-way valves.

Both types of valves can be simultaneously controlled through a common 
software interface called the External Valve Sequencer  (described in section 
E.7) which is available from the Tools menu on the GUI.

Picarro offers two rotary valve and two solenoid valve solutions:

• A0311, 16-Port Distribution Manifold

• A0311-S, 16-Port Distribution Manifold (Silco) which is optimized for use
with sticky and reactive gases.

• S3112, 3-Way stainless steel solenoid valve with 1/4” fittings

• S3136, 3-Way stainless steel solenoid valve with 1/8” fittings

E.2 A0311 16-Port Distribution Manifold

Compatibility 
The A0311 () is broadly compatible with most Picarro analyzers except for those 
with known surface and chemical compatibility issues (such as the G2103, 
SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114). 

Function 
The A0311 and External Valve Sequencer GUI makes it easy to program the 
sequence and duration of sample intake from various attached sampling lines, 
flasks, or bags. The manifold is controlled using either the Picarro analyzer GUI or 
an external hand-pad (included with the A0311). 

The A0311 samples up to 16 gas sources. During operation, the selected line is 
routed through the valve into the analyzer. The 15 lines that are not selected 
terminate in the valve. 
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NOTE 

For detailed instructions on integrating the A0311 with your analyzer, refer to the 
16-Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

Figure 91: A0311 – 16-port Distribution Manifold 

E.3 A0311-S 16-Port Distribution Manifold (Silco)
Compatibility
The A0311-S (Error! Not a valid bookmark self-reference.) is broadly 
compatible with all Picarro analyzers but is optimized for use with sticky and 
reactive gases in the following platforms, nominally: 

• G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114

Function 
For users who require faster response performance, the A0311-S is a 16-Port 
distribution manifold with a flow through valve for reduced memory effects. 
Designed to optimize response time in the presence of reactive gases, the 
A0311-S uses SilcoNert® coated components, PFA tubing, and an additional 
vacuum pump. 

The sampling duration and sequence is easily programmed through the Picarro 
External Valve Sequencer GUI. This design is ideal for fast switching between 
different locations for specialty applications in Semiconductor, Pharmaceutical, 
Environmental research, and other industries.  
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NOTE 

For detailed instructions on integrating the A0311-S with your analyzer, refer to 
the 16-Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-
0038). 

Figure 92: A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler 

E.4 Valve Control Configurations
For all models of Picarro analyzers, the rotary valve control is disabled in the 
factory default setting. The solenoid valve control, however, is enabled by default 
for all solenoid valve connectors.  

To configure an analyzer for operation with an A0311 rotary valve, the user must 
first confirm that the COM port chose on the back of the instrument for connection 
to the rotary valve is consistent with the COM port specified in the Setup Tool. 
Refer to  located in section 1  for instructions to change to rotary valve 
configuration (the Valve Sequencer MPV field) and to ensure the correct COM 
port is enabled. 

CAUTION 

Only use supported 12V, <500 mA, solenoids (listed above in section E.1). Using 
unsupported solenoids may result in damage to the power board. 

E.5 Setting Up Solenoid Valves
The Valve Sequencer software can control up to six solenoid valves. Each valve 
should operate using 12 VDC with a maximum quiescent current of 500 mA. Most 
analyzers come with a valves cable that can be connected to the solenoid valves, 
and if not, one can be purchased by contacting support@picarro.com. 
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CAUTION 

Be careful to avoid shorting the solenoid valve output pins, as this will blow the 
relays on the power board, requiring a costly replacement. 

The valve connector cable should be connected to the 15-pin connector at the 
lower left corner of the analyzer. There are six pairs of wires with connectors 
labeled V1, V2, … V6 with 2-pin female Molex connectors (Molex #43020-0200) 
for connection to the solenoid valves. For valves wired with matching Molex 
connectors, connect V1 to the solenoid valve 1, V2 to solenoid valve 2, etc. Do 
not connect the solenoid valve to the analyzer ground – use only the provided 
electrical connectors. 

E.6 Setting up a Rotary Selector Valve
The (null modem) 9-pin female connector cable should be attached to its 
corresponding 9-pin male port (COM 2) on the analyzer. The other end of the 
cable connects to the 9-pin port on the A0311. Please note the 9-pin connector 
cable is not supplied with the instrument – only as part of the A0311 kit. 

E.7 External Valve Sequencer Software Overview
The External Valve Sequencer software allows the user to define a sequence of 
(repeating) steps within which rotary valve positions and/or solenoid valve 
positions can be defined uniquely at each step. 

Opening the Sequencer 
From the CRDS Data Viewer, Users dropdown menu login using your username 
and password. Then, from the Tools drop-down menu, select Show Valve 
Sequencer GUI. The Picarro valve sequencer window displays (Figure 92), but 
typically sitting behind the main GUI. Hitting alt-tab brings the Valve Sequencer 
GUI to the front. 
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Figure 93: Launching the Valve Sequencer GUI 

Valve Sequencer UI Menus 
The sequencer GUI provides the dropdown menu choices shown here. 

Figure 94: Valve Sequencer UI Dropdown Menus 

For the following functional descriptions, Figure 94 shows a full view of an 
example sequencer UI. 
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Figure 95: External Valve Sequencer UI 

The Current Step #, the Remaining Time (min), and the Current Valve State 
are shown in the topmost row of the valve sequencer command window. The 
duration of each step is set in decimal minutes; for example, 15 seconds would be 
entered in as 0.25 minutes. 

While a sequence is inactive, Current Step # will typically read “0.”  Once the 
user has selected Start Sequence from the Action menu, or once the user has 
hit Apply from the GUI, the Current Step value will change to 1, corresponding to 
the first step defined below it, and will continue through the steps, returning to 
Step 1 once the last step is completed.  

If a user wishes to perform a set of steps only once, they may set a final step with 
a very long duration, or wait until the sequence is finished, and at the end of the 
last step, click Stop Sequence from the Action menu. 

Current step and valve state 
status panel (when sequencer 
is running) 

Sequencer 
configuration controls 
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Under Action, the Go to First Step menu item restarts the sequence from step 1. 
When the first step in the sequence starts, the “Current Step” value will change to 
“1”. This will begin the sequence if the sequence is currently active. 

E.8 Programming and Saving a Valve Sequence
Each “step” in the sequence can be used to set the rotary valve to a given position 
or activate selected solenoid valve(s) for a set period. Multiple steps can be 
carried out in sequential order to switch between different gas sources, flush out a 
manifold, or to perform other gas handling operations.  

1. Create the number of desired steps in the sequence by clicking the
up/down arrow for Total Steps.

2. For each step, select the box for each solenoid valve to be opened. The
checkmark in the Current Valve State window indicates a solenoid
valve is set to its “normally closed” value in the case of a 3-way, or to its
“open” value in the case of a 2-way on/off valve. The positions from left
to right correspond to solenoid valves V1 to V6.

3. The rotary selector valve position can be set in the column labeled Rot.
Valve Code. Enter the number that corresponds to the desired valve
position. A value of 1 in this field corresponds to position 1 on the rotary
valve. Only one rotary position can be selected per step.

4. The upper right box, Current Rot. Valve Code, displays the current
value while a sequence is active. It should be white if a rotary valve is
connected, turned on, and detected by the software. If the box is grayed
out, the rotary valve is not detected (if so, consult your rotary valve
manual).

5. For each step, set the desired Duration. This is determined by the value
entered in the Duration (min) field, where the duration of the step is in
minutes. If duration values are set to <0.1 minutes, they may not be
carried out accurately.

6. The Valve Code column (not used with the rotary valves) is a
configuration-dependent, read-only display field that shows the total
state of that particular step in a numerical binary sum of form 2(Valve Number

-1). When powered, the following valve values are produced, and then
added together for the final Valve Code.

Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1 

Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2 

Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4 

Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8 

Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16 

Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32 
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The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 
1-6 are all powered. All other combinations of valves are unique binary
sum values which denote the specific combination of any of the six
valves.

This Valve Code value active at a particular point in time can be shown 
in the main Picarro software GUI as SolenoidValves or sometimes 
ValveMask (this may require going to Settings > Service Mode > 
password picarro). The Rotary valve code can be displayed as 
MPVPosition. 

Above is a 15 minute sequence, currently on position 1, using solenoid valves only, in 
positions 3, 5, and 6 to determine flow path. 

Figure 96: Example 15 Minute Sequence 

7. Once the valve sequence has been programmed, it can be saved by
selecting Save Valve Sequence File under the File menu (Figure 93).
The sequence may be saved with any name the user chooses.
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E.9 Loading and Running a Saved Sequence
Loading a Saved Sequence

1. Under the File menu, select  Load Valve Sequence.

All the sequence files are in:

/Home/Picarro/I2000/InstrConfig/ValveSequencer/Name of the Sequence File 

2. To load an existing valve sequence file, select the desired sequence
name.

If the user has been running a different sequence from the one that was
loaded, the user needs to press Run Next Step to initialize the newly
selected sequence, or alternately go to File > Go To First Step and Start
Sequencer.

Running a Sequence 
1. Under the Action menu, select Start Sequencer.

This selection will change to Stop Sequencer once the sequence starts.
(The sequencer should be activated if it was disabled, but not necessarily
to change from one sequence to another.) The sequence will repeat itself
indefinitely until disabled or the software is exited.

2. Once the sequencer is running, the user can select Hide Sequencer
Interface under the Action menu; the sequence will continue to run
even with the UI hidden, and will automatically continue if the instrument
ever loses power from the wall and restarts after power is restored.
(However, the timing of the sequence will be offset relative to the
intended cadence.)

3. To bring the sequencer interface back into view, from the main Picarro
GUI, go to Tools > Show/hide Valve Sequencer again.

Skipping Steps or Advancing to a Particular Step 
If desired, the valve sequence can be forwarded to the next step of the sequence 
by clicking the Run Next Step button on the UI. To jump to a particular step, 
increment the Run Step # field and click Apply. 

Stopping the Sequencer 
1. Under the Action menu, select Stop Sequencer.

This will leave all valves in their current state. In some situations, it is
convenient to program the last step in the sequence to be a safe or
default valve state.
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2. Should the user need to put the solenoid or rotary valves into a
safe/default state, the sequencer can be advanced to the last step using
the Run Next Step button.

Resetting Valves 
Under the Action menu, selecting Reset All Valves will deactivate/reset all 
valves to their default state.  

Valve Sequencer Data Records 
For each individual measurement the analyzer makes, the valve codes and rotary 
valve positions corresponding to the valve state(s) at that point in time are saved 
alongside the concentration data as long as the variable is selected from the 
Picarro Launch Pad, Settings, Data Logger Setup, Data Columns window. 

If the desired variable is not available, select Service Mode and then select the 
value from the variables that populate into the Data Columns window and click 
Save. Note the changes will take effect after the software restarts. 

Figure 97: Data Logger Service Mode 
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If no solenoid valves are present, the codes will be recorded regardless of 
whether a valve is connected.  

If no steps are defined, and no sequence is active, these values will display 0. 

E.10 Scheduling a Sequence
Users may schedule a sequence to start at a particular time in the future, often at 
the top of the hour, or at midnight for a recurring sequence with an hourly or daily 
cadence. The Schedule Sequence button is typically greyed out when the user 
shows the valve sequencer because the start time has passed. To begin a run in 
the future, select the desired date under Start Date, and the desired time under 
Start Time. When both values are in the future, the Schedule Sequence button 
will become active, and the user may click it. When the scheduled time arrives, 
the sequence will start itself automatically. 
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APPENDIX F – Relative Humidity 
Conversion 

H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 
volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the 
concentration can be related to the water vapor pressure (PW) and the total pressure (P). 

𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃

A popular way to express volumetric concentration when working with humidity is in 
terms of total (dry) gas. 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙
𝑃𝑃𝑊𝑊

(𝑃𝑃 − 𝑃𝑃𝑊𝑊) 

The two concentration definitions can be related by 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤
(100−𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤)

or 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 =
100∙𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�100+𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑�

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 
vapor pressure (PWS). 

𝑅𝑅𝑅𝑅 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃𝑊𝑊𝑊𝑊

There are several empirically generated equations that provide the saturation vapor 
pressure as a function of temperature (T). A simple and effective relationship for use 
within a temperature range of -45 °C to 60 °C is provided by the Mangus formula with 
coefficients adjusted by Sonntag [1]. 

𝑃𝑃𝑊𝑊𝑊𝑊 = 𝛼𝛼 ∙ 𝑒𝑒�
𝛽𝛽∙𝑇𝑇
𝑇𝑇+𝜆𝜆� 

Where, 𝛼𝛼  = 4.584 Torr, 𝛽𝛽 = 17.62 and λ = 243.12 °C 

Combining the equations shown above yields the final relationship for converting the wet 
and dry definitions of concentration to relative humidity. 

For example, a wet concentration of 1.5% H20 at 18.0 °C and 760.0 Torr yields a 
relative humidity of 73.8%. 

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 
72.7%. 
[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based
on the ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344

𝑅𝑅𝑅𝑅 = 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 ∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� =  
100 ∙ 𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 + 100�
∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� 
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APPENDIX G – Introduction to CRDS 
Technology 

Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration in a sample. They are based on wavelength-scanned cavity 
ring-down spectroscopy (WS-CRDS), a technology in which light travels many times 
through the sample, creating a very long effective path length for the light to interact with 
the target gas, thus enabling excellent detection sensitivity in a compact and rugged 
instrument. 

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a computer with a
hard drive to store and analyze data. The single analyzer module controls the
operation of the system and converts spectroscopic measurements into gas
concentration data.

• The External Vacuum Pump draws the sample gas through the instrument.

G.1 Cavity Ring-Down Spectroscopy (CRDS)
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 
isotopologue (e.g., H2

18O, 13CO2, 15N14N16O) uniquely absorb specific wavelengths 
of near-infrared light. The strength of the light absorption is related to the 
concentration of a molecule in a sample and the distance that light travels through 
the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to detect 
trace gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy 
(CRDS), on the other hand, is one thousand to one million more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity and 
the time-based measurement. In the cavity, a series of mirrors reflects the infrared 
light through the sample, increasing the path length. For a Picarro cavity of only 
25 cm in length, the effective path length of the cavity can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity where 
three mirrors reflect the laser light as seen in Figure 98. The light enters through 
the mirror closest to the laser, bounces off the angled mirror in the lower right 
corner of the cavity, travels to the hemispherical mirror at the top of the cavity, 
bounces toward the mirror in the lower left corner of the cavity, and then returns to 
the first mirror. This motion becomes a continuous traveling light wave, which is 
represented by the dark orange path in Figure 98. 
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Figure 98: Schematic of Picarro CRDS Analyzer Cavity 

When the laser is on, the cavity quickly fills with laser light. A small amount of the 
laser light is transmitted through the mirror closest to the photodetector, which 
turns the incident light into a signal that is directly proportional to the light intensity 
in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the mirrors 
have slightly less than 100% reflectivity (99.999%), the light inside the cavity 
steadily leaks out of the cavity. The intensity of the light reaching the detector 
decreases, falling exponentially until it reaches zero. This decay, or “ring-down,” is 
measured in real time by the photodetector. 
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G.2 Relating Ring-Down Time to Absorption
Intensity

The time it takes to ring-down is inversely related to the total optical loss in the 
cavity, including the strength of molecular absorption at a given wavelength of 
light. For an empty cavity, the time it takes for the intensity to decrease by a given 
percent is determined solely by the reflectivity of the mirrors. A cavity containing 
gas that absorbs light will have a shorter ring-down time than an empty cavity. As 
the light circulates in a cavity with a gas sample, the molecular absorption by the 
gas results in a decrease of the light intensity. 

Determining absorption intensity at a specific wavelength requires comparing the 
ring-down time of an empty cavity to the ring-down time of a cavity that contains 
gas (Figure 99). A cavity can be empty if it contains no gas; it will also appear 
empty if the molecules of the sample inside the cavity do not interact with the 
specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by switching the 
light to wavelengths that are not absorbed by the target molecules. The analyzer 
subsequently measures ring-down times at wavelengths that are absorbed by the 
target gas. The analyzer automatically and continuously compares these two 
types of ring-down times, and the software uses those comparisons to calculate 
absorption intensities. 

Figure 99: Light Intensity as Function of Time in CRDS System 
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G.3 Converting Absorption Intensity to
Concentration

Plotting the absorbance at each measured wavelength generates an optical 
spectrum. This spectrum contains absorbance peaks that are unique to each 
molecule in the sample. The height of a particular absorption peak is proportional 
to the concentration of a molecule that generated the signal.  

The height of the peak is calculated by subtracting the maximal absorbance from 
the baseline absorbance. Figure 73 shows a plot of ideal optical spectra with a 
clean, uniform baseline on either side of the absorption peak. 

Figure 100: Absorption Spectral Curve 

However, optical spectra often contain several absorption lines, nested closely 
together. A particular absorption peak may be visible between lines, but the 
absorption may not return to the baseline before it rises in response to another 
molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak by 
modeling the absorption peaks from other surrounding molecules and subtracting 
contributions from neighboring peaks to the absorption intensity.  
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G.4 Spectral Precision and High Sensitivity
Measurements

Picarro analyzers contain two features that provide high spectral precision: 

• A proprietary wavelength monitor (WLM) that measures the absolute laser
wavelength to a precision that is a few orders of magnitude narrower than
the spectral linewidth: Picarro’s patented WLM measures absolute laser
wavelength to a precision more than 1,000 times narrower than the
observed Doppler-broadened linewidth for small gas-phase molecules.
The instruments lock the laser to the WLM, and then the monitor tunes to
wavelengths known to be maximally and minimally absorbed by the target
molecule. The result is closely clustered absorption intensities, measured
at wavelengths just before peak absorption, at peak absorption, and just
after peak absorption, as the absorbance returns to the baseline.

• Precise temperature and pressure control in the sample cavity: Accurate
absorption measurements at precisely known wavelengths account for
little unless the temperature and pressure of the CRDS measurement
cavity are known. The observed line intensity and shape depend on the
temperature and pressure inside the sample cavity. Small temperature
and pressure instabilities can result in large concentration errors due to
fluctuating peak heights and baselines. To completely minimize instrument
measurement drift, temperature and pressure must be actively stabilized
to constant values.

For precise temperature control, the sample cavity is surrounded by layers of 
thermally insulating material to provide a high degree of passive thermal stability. 
The cavity is further actively stabilized by means of a solid-state heating system 
locked to the output of a thermal sensor. This enables the temperature of the 
cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure data in a 
feedback loop to control proportional valves that adjust the inlet and outlet gas 
flow of the cavity. 
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APPENDIX H – Limited Warranty 
Picarro, Inc. warrants its Products to be free from defects in material and workmanship 
and to perform in the manner and under the conditions specified in the Product 
specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and no 
person is authorized to bind Picarro for any obligations or liabilities beyond this warranty 
in connection with its Products. This warranty is made to the original Purchaser only, is 
non-transferable and may only be modified or amended by a written instrument signed 
by a duly authorized officer of Picarro. Sub-systems manufactured by other firms, but 
integrated into Picarro Products, are covered by the original manufacturer’s warranty 
and Picarro makes no warranty, express or implied, regarding such sub-systems. 
Products or parts thereof which are replaced or repaired under this warranty are 
warranted only for the remaining, un-expired portion of the original warranty period 
applicable to the specific Product replaced or repaired. 

WARRANTY DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT 
OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to have 
Picarro repair or replace such defective Product or credit the Purchaser’s account, 
whichever Picarro may elect in its sole discretion. If it is found that any Product has been 
returned which is not defective, the Purchaser will be notified, and such Product returned 
at the Purchaser’s expense. In addition, a charge for testing and examination may, at 
Picarro’s sole discretion, be made on any Product so returned. 

These remedies are available only if: 1) Picarro is notified in writing by the Purchaser 
promptly upon discovery of a Product defect, and in any event within the warranty 
period; 2) Picarro’s examination of such Product discloses to Picarro’s satisfaction that 
such defects actually exist and the Product has not been repaired, worked on, altered by 
persons not authorized by Picarro, subject to misuse, negligence or accident, or 
connected, installed, used or adjusted otherwise than in accordance with the instructions 
furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 
amended by a written instrument signed by a duly authorized officer of Picarro: 
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ADJUSTMENT – No electrical, mechanical, or optical adjustments to the product(s) are 
permitted. 

PARTS AND LABOR - New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement parts 
are warranted for the remaining portion of the original warranty period. There will be no 
charge for repair of products under warranty where the repair work is done by Picarro, 
Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from improper 
handling or cleaning procedures. This applies specifically to those items subjected to 
excess laser radiation, contaminated environments, extreme temperature, or abrasive 
cleaning. Damage due to ESD, abuse, misuse, improper installation or application, 
alteration, accident, negligence in use, improper storage, transportation, or handling. No 
warranty shall apply where the original equipment identifications have been removed, 
defaced, altered or where there is any evidence of alterations, adjustments, removal of 
protective outer enclosure, any attempt to repair the product by unauthorized personnel 
or with parts other than those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT - Your analyzer should be inspected and tested as soon as it is 
received. The product is packaged for safe delivery. If the product is damaged in any 
way, you should immediately file a claim with the carrier or, if insured separately, with 
the insurance company. Picarro, Inc. will not be responsible for damage sustained in 
shipment. All Picarro products are F.O.B. origin, shipped from the Picarro factory or 
Picarro distributor. The price of all Products, unless otherwise specifically stated, is Ex- 
Works, Sunnyvale, CA as defined by Incoterms, 2020. The cost of normal packaging for 
shipment is included in the invoiced price. Where Buyer specifies special packaging, a 
charge will be made to cover any extra expense. 

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local distributor for 
assistance. Give our representative the full details of the problem. Helpful information or 
shipping instructions will be provided. If requested, estimates of the charges for non-
warranty or other service work will be supplied before work begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise Authorization 
Number from Picarro, Inc. prior to returning units. Products being returned for repair 
must be shipped in their original shipping cartons to avoid damage. 
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